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Preface

Oracle Application Express End User’s Guide offers an introduction to using Oracle
Application Express applications from an end user's perspective. This guide explains
how to use Websheets and interactive reports and use applications that include the
ability to upload data.

To learn more about developing Oracle Application Express applications, see Oracle
Database 2 Day + Application Express Developer’s Guide and "Quick Start" in Oracle
Application Express Application Builder User’s Guide.

Topics:

¢ Topic Overview

e Audience

* Documentation Accessibility
® Related Documents

e Conventions

Topic Overview

This document contains the following sections:

Title Description

Changes in This Release Describes changes in this document for Oracle
Application Express, release 4.2.

About Oracle Application Offers a brief introduction to the Oracle Application

Express Express development environment.

Using Websheets Offers an overview of Oracle Application Express
Websheet applications.

Using Interactive Reports Offers an overview of using Oracle Application Express
interactive reports.

About Uploading Data Describes how to import data into an Oracle Application
Express application using an existing application Data
Loading Wizard.

Vii



Audience

Oracle Application Express End User’s Guide is intended for end users who are running
Oracle Application Express applications. To use this guide, you must have a general
understanding of relational database concepts and an understanding of the operating
system environment under which you are running Oracle Application Express.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at ht t p: / / www. or acl e. coni pl s/t opi ¢/ | ookup?
ct x=accé& d=docacc.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For
information, visitht t p: / / ww. or acl e. coni pl s/ t opi ¢/ | ookup?

ct x=acc& d=i nf o or visitht t p: / / www. or acl e. cont pl s/t opi c/ | ookup?
ct x=acc& d=t r s if you are hearing impaired.

Related Documents

viii

For more information, see these Oracle resources:

® Oracle Application Express Release Notes

o Oracle Application Express Installation Guide

® Oracle Database 2 Day + Application Express Developer’s Guide
® Oracle Application Express Application Builder User’s Guide

® Oracle Application Express Administration Guide

® Oracle Application Express SQL Workshop Guide

® Oracle Application Express API Reference

* Oracle Application Express Migration Guide

For additional documentation available on Oracle Technology Network (OTN)), visit
the Oracle Application Express website located at:

http://ww. oracl e. com t echnet wor k/ devel oper -t ool s/ apex/ over vi ew
i ndex. htm

For additional application examples, go to the Learning Library. Search for free online
training content, including Oracle by Example (OBE), demos, and tutorials. To access
the Oracle Learning Library, go to:

http://wwv. oracl e. com t echnet wor k/ t ut ori al s/ i ndex. ht m

Printed documentation is available for sale in the Oracle Store at:
http://shop. oracle. cont

If you have a user name and password for OTN, then you can go directly to the
documentation section of the OTN website at:


http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
http://www.oracle.com/technetwork/developer-tools/apex/overview/index.html
http://www.oracle.com/technetwork/developer-tools/apex/overview/index.html
http://www.oracle.com/technetwork/tutorials/index.html
http://shop.oracle.com/

http://ww. oracl e. coni t echnet wor k/ i ndexes/ docunent ati on/

i ndex. ht m

Conventions

The following text conventions are used in this document:

Convention

Meaning

boldface

italic

nonospace

Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.



http://www.oracle.com/technetwork/indexes/documentation/index.html
http://www.oracle.com/technetwork/indexes/documentation/index.html




Changes in This Release

This preface contains:

* Changes in Oracle Application Express Release 4.2

Changes in Oracle Application Express Release 4.2

The following are changes in Oracle Application Express End User’s Guide for Oracle
Application Express release 4.2.

New Features

The following features are new in this release:

Websheets

Toolbar Menu Enhancement

The existing toolbar menu options have been moved and new options have
been added for reports. These changes are designed to make it easier, more
productive, and more intuitive for users to navigate from within Websheets.

See “Using Websheets ”.

Link Directly to Data Grids

Provide users with the ability to utilize a link directly to edit a data grid or data
grid row (form view) which can be exposed or emailed for easier access.

See “Creating a Bookmark Link to a Data Grid”.

Interactive Reports

Interactive reports modernized

All interactive reports feature a modernized user interface to facilitate ease-of-
use.

Date Columns can use Equal (=) Operator

Enables users to filter on a specific date using the equal (=) operator.

See “Using Interactive Reports ”.

Data Upload

Provide Column Aliases

Xi



Other Changes

The following are additional changes in the release:

Xii

To avoid end users having to know table column names, developers can define
aliases for columns to be uploaded. Table column names can be misleading and
confusing for end users, especially for those columns where a lookup has been
defined, for example, instead of requiring DEPTNOthe user should upload
Department Name.

Lookup Key Improvements

Instead of only allowing one column lookup and returning a numerical value,
these improvements enable three columns to be specified to identify the lookup
value which can be of any data type. This is required to uniquely identify a
value where the lookup table has multiple part keys.

Transformation Rule Enhancement

For users uploading data with different character sets, you can now specify the
character set used to create the file so that it can be updated correctly.

Ensure Concurrency

Developers can define a column for concurrency which is used to ensure that
data being updated has not been changed since the end user began the upload
process. This feature is important when end users are uploading records to a
table that is regularly updated.

See “About Uploading Data ”.

¢ All content has been updated to reflect new functionality.

e Screen captures and graphics have been added and updated to reflect Oracle
Application Express release 4.2 user interface enhancements.
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About Oracle Application Express

This document offers an introduction to using Oracle Application Express applications
from an end user's perspective. To learn more about developing Oracle Application
Express applications, see Oracle Database 2 Day + Application Express Developer’s Guide
and "Quick Start" in Oracle Application Express Application Builder User’s Guide.

Topics:

® About Oracle Application Express

e About Websheet Applications

* About Database Applications

* About Browser Requirements

About Oracle Application Express

Oracle Application Express is a rapid web application development tool for the Oracle
Database. Through wizards or direct input, developers can assemble an HTML
interface (or application) on top of database objects. Each application is a collection of
linked pages using tabs, buttons, or hypertext links.

By creating an application, users can manage, manipulate, and display data in the
Oracle Database. Using Oracle Application Express, developers can build two types of
applications:

* Websheet applications

¢ Database applications

About Websheet Applications

A Websheet is an interactive web page that combines text with data. Websheet
applications include navigation controls, search capability, and the ability to add
annotations such as files, notes, and tags. To learn more, see “Using Websheets ”.

About Database Applications

Using only a web browser and with limited programming experience, Oracle
Application Express enables developers to create powerful database applications. A
database application is an interactive user interface (UI) that enables users to quickly
add, update, or display information stored in the Oracle Database. This information
can be displayed in many formats, including static and interactive reports, forms,
maps, charts, and maps.

About Oracle Application Express 1-1



About Browser Requirements

This guide explains how end users can customize an interactive report. With an
interactive report, end users can customize the appearance of report data through
searching, filtering, sorting, column selection, highlighting, and other data
manipulations. Plus, end users can save their customizations and download the report
locally. To learn more, see “Using Interactive Reports ”.

This guide also explains how to import data into an Oracle Application Express
application using an existing application Data Loading Wizard. To learn more, see
“About Uploading Data ”.

About Browser Requirements

Running an Oracle Application Express application requires a web browser that
supports Java Script and the HTML 4.0 and CSS 1.0 standards. The following browsers
meet these requirements:

¢ Microsoft Internet Explorer 7.0 or later version
* Mozilla Firefox 14 or later version
* Google Chrome 21 or later version

* Apple Safari 5.0 or later version

1-2 End User's Guide



2

Using Websheets

Websheet applications are interactive web pages that combine text with data. These
applications are highly dynamic and defined by their users. Websheet applications
include navigation controls, search capabilities, and the ability to add annotations such
as files, notes, and tags. Websheet applications can be secured using access control lists
and several built-in authentication models.

Topics:

Running a Websheet

About Using Websheets

Managing Websheet Pages

About Adding and Editing Page Sections
About Text Sections

About Navigation Sections

About Adding Data Grids

About Adding and Editing Data Content
About Adding Data Reports

About Data Sections

About Chart Sections

About PL/SQL Sections

Understanding Markup Syntax
Managing Annotations

Managing Websheet Applications

Viewing Websheets

See Also:

"About Websheet Applications" in Oracle Application Express Application Builder

User's Guide

Using Websheets 2-1



Running a Websheet

Running a Websheet

To run a Websheet, a developer provides you with a URL and login credentials (that
is, a username and password).

To run a Websheet:

1. Click the supplied URL, or enter it in your browser's Address field.
A Login page appears.

ORACLE" Application Express

EnterWehsheets credentials.

Username

Password

< Return to Development ‘ ‘ Reset Password ‘

2. On the Login page:
a. Username - Enter your username.
b. Password - Enter your password.

c. Click Login.
The Websheet application appears.

See Also:

"Running a Websheet" in Oracle Application Express Application Builder User’s
Guide

About Using Websheets

This section describes interface elements common to all Websheet applications.

Topics:

¢ Using Breadcrumbs and Navigation Sections
e About Online Help

¢ About the Logout Link

* About Websheet Search

e About the Control Panel

2-2 End User's Guide



About Using Websheets

Using Breadcrumbs and Navigation Sections

A breadcrumb displays at the top of every Websheet page. Positioning the mouse over
the home breadcrumb displays a submenu of links to all Websheet pages. To view
another page, click the child breadcrumb entry.

View Create ~ Edit ~ Data Grid ~ Administration ~
Haorme =

Projects
Systams

=
D Frojects
: D Systems

* AnyCo IT Department

About Navigation Sections

Websheets can contain multiple pages. Each navigation section includes a hierarchical
tree that enables you to navigate between pages or page sections.

View » Create ~ Edit ~ Data Grid ~ Administration »

Horme »

™! [Expand All] [Reset
4 D Home

D Frojects

: D Systems

Click the arrows on the left to expand or collapse the tree. To link to a specific section
or page, click it. Click Expand All to view all pages and page subsections. Click Reset
to return the tree to the default display. To learn more, see “About Navigation
Sections”.

Showing and Hiding Page Sections

You can hide and show page sections. To hide and show a section, click the arrow to
the left of a section name.

Using Websheets 2-3



About Using Websheets

View » Create Edit = | Data Grid + Administration -
Home » Systzms #
(~) systems  Edit

» Syateme Cverview
» Syzteme Maintenance

¥» Furchazing Projections
(3) Systems Overview  Edit

() systems Maintenance - Edt

Laptops and Workstations

Servers and other storage media

About Online Help

[Q Search Websheet ]

A Help button displays in the upper right corner of each page. Clicking Help displays
a small Help system that provides an overview of Websheet functionality. Available
tabs include: About, Overview, Access Control, Markup Syntax, Data Grid,
Application Content, and FAQ.

Tip:

The content of this online Help system is also covered in depth in "About
Websheet Applications" in Oracle Application Express Application Builder User's
Guide.

About the Logout Link

£+ Builder BEEEEEM Logout

[Q Search Websheet ]

To log out of a running Websheet, click Logout in the upper right corner. The Login
page appears. To return to Application Builder, click Return to Development.

About Websheet Search
The Search Websheet field displays in the upper right of each Websheet page.

2-4 End User's Guide



About Using Websheets

Q) Search Websheet

““Edit -+ | ControlPanel

=& Mew Section

"+ Edit Sections

["J New Page

L=-| New Page as a Copy
[~} Edit Page

-~ Page Directory

[ New Data Grid

Use Search Websheet to perform case insensitive searches of application content.
Search results display in a report.

Home * Search

[a e | gt |

FoundIn Content Name Section Context Updated(y) Updated By Created Created By
HARDWARE LAPTOPS AND 45

Data Grid Systems WORKSTATIONS LAPTOPS AND 45 seconds termi seconds  tert

= Maintenance WORKSTATIONS FOR DIFFERENT ago ago
TEAMS IQUEST PC g

Data Grig BN HARDWARE LAPTOPS LAPTOPS 46seconds 46 o ten

ALl pychases FOR NEW EMPLOYEES IQUEST PC  ago em seconds - term

ago

Once the search results display, use the Search region on the right side of the page to
control what content to search. Searchable Content options include:

Page Name

Page Alias

Page Description

Section title

Section content

File Name, Alias, Description
Tags

Notes

Using Websheets 2-5



Managing Websheet Pages

e Data Grid Data

To refresh the view, click the Search button.

About the Control Panel

The Control Panel displays on the right side of most Websheet pages. To hide or
display the Control Panel, click the arrow to the right of the region title.

Control Panel w.

= New Section

_+ Edit Sections

") New Page
7 New Page as a Copy
~+ Edit Page

Page Directory

4 New Data Grid

The Websheet Control Panel contains the following options:

¢ New Sections. See “About Adding and Editing Page Sections”.
¢ Edit Sections. See “About Adding and Editing Page Sections”.
* New Page. See “Adding a New Page”.

* New Page as a Copy. See “Copying an Existing Page”.

e Edit Page. See “Editing Page Details”.

* Page Directory. See “Viewing the Page Directory”.

¢ New Data Grid. See “Creating a Data Grid”.

Managing Websheet Pages

You can add pages to a Websheet manually, or copy existing pages.

Topics:
¢ Adding a New Page
¢ Copying an Existing Page
¢ Editing Page Details
Tip:

You can also add a new page by clicking New Page and New Page as a Copy
on the Control Panel.

Adding a New Page
To add a new Websheet page:

2-6 End User's Guide



Managing Websheet Pages

1. Run the Websheet application. See “Running a Websheet”.

2. From the Create menu, select New Page.

3.  On Create Page:

a. Name - Enter a page name. The page name displays as the window title and
in the breadcrumb.

b. Page Alias - Identify the page alias. This alias enables you to link to this page.
See “Linking to a Page”.

c. Parent Page - If this page is part of a page hierarchy, then select the parent
page.

d. Click Create Page.

Copying an Existing Page

To copy an existing page:

1. Run the Websheet application. See “Running a Websheet”.

2. From the Create menu, select New Page as a Copy.

3. In New Page Name, enter the name of the new page.

4. Click Copy Page.

A success message appears.

5. Select one of the following;:

Editing Page Details

View Current Page
View New Page
Tip:

You can change the parent page by editing the Page Details. See “Editing Page
Details”.

On Page Details, you can change the page name, alias, parent page, or page
description.

To edit page details:

1. Run the Websheet application. See “Running a Websheet”.

2. From the Edit menu, select Edit Page.

3. On the Details Page:

Name - Identifies the name of the page. The page name displays in the
window title and in the breadcrumb.

Alias - A page alias enables you to create links in page sections to other pages.
A page alias must be unique within an application. See “Linking to a Page”.

Using Websheets 2-7



About Adding and Editing Page Sections

4.

¢ Owner - Identifies the owner of the page.

* Parent Page - Identifies the parent page. The defined parent page is used to
construct breadcrumbs and navigation between pages.

* Page Description - Descriptive text that describes the page.
Click Apply Changes.
A success message appears.
Tip:
You can also edit page details by clicking Edit Page on the Control Panel.

About Adding and Editing Page Sections

This section describes how to add and edit page sections.

Topics:

About Section Types
About Editing Sections
Deleting Page Sections

Editing Section Titles and Display Order

About Section Types

Websheets are organized into pages which consist of containers called sections. To
each Websheet page, you can add the following section types:

Text - Display entered text, inline images, and inline reports, and links to reports,
data grids, other pages, files, external URLs, and so on. You can create and modify
text sections using an intuitive WYSIWIG editor. See “About Text Sections”.

Navigation - Add dynamically generated navigation to subordinate pages or page
sections. See “About Navigation Sections”.

Data - Create inline reports based upon a data grid or report. See “About Data
Sections” and “About Adding Data Reports”.

Chart - Create inline charts based upon a data grid or report. See “About Chart
Sections”.

PL/SQL - Select a data grid to generate SQL and SQLVALUE queries to use within
your application. See “About PL/SQL Sections”.

About Editing Sections

To edit a page section:

1.

2.

2-8 End User's Guide

Run the Websheet as described in “Running a Websheet”.

Click the Edit icon that displays in the upper right of each section.



About Adding and Editing Page Sections

View » Create ~ Edit ~ Data Grid ~ Administration - | Q, Search Websheet
Horme » = a
¥ [Expand All] [Reset . Edit Centrol Panel
4 D Home # New Section
D Frojects —+ Edit Sections
: D Systems ;
+ New Page
~) AnyCo IT Department - Edit | New Page as a Copy
"+ Edit Page
o . pecializes in ) custom soly lientz in the zervices )
inclustry. With a total of 125 empls orp iz expanding itz businezs to extend conzulting services and solutions Page Directory
to cliznts across Morth Amesrica.

2 New Data Grid

The Edit Section page appears.

View * Create v Edit Data Grid * Administration ¥

Sections £+ < | Edit Section
s teri — 64 minutes ago
= Page Home
AnyCo IT Department
e s ago Sequence * 20
=] Projects Summary
teri — 64 minutes aga0 Title * AnyCo IT Department

Systems Summary
terri — B4 minutes ago Content

AnyCo Corp is a consulting firm founded in 2008, AnyCo Corp specializes if
industry. With a total of 125 employees, AnyCo Corp is expanding its busin
across Morth America.

Tip:
The left side of the Edit Section page lists all sections on the current page. The
current section is highlighted. To go to another section, select it.

3. Edit the section and click Apply Changes.

Deleting Page Sections

To delete a page section:
1. Run the Websheet as described in “Running a Websheet”.

2. Click the Edit icon that displays in the upper right of the section.
The Edit Section page appears.

3. C(lick Delete.
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Editing Section Titles and Display Order
You can change the section title or display order on the Edit Sections page.
To edit all sections:
1. Run the Websheet application. See “Running a Websheet”.

2. From the Edit menu, select Edit Sections.

The Edit Sections page appears.

Home * Edit Sections

Section Title Type

Fage Mavigation £

AnyCo [T Department Text FLN

Frojects Summary Chart —

W

ystems Summary Text

3. To edit the section title, enter a new title.

4. To change the section order, click the Up and Down arrows adjacent to the section
title.

5. Click Apply Changes.
Tip:
You can also edit sections by clicking Edit Sections on the Control Panel.
About Text Sections
To add text to a Websheet page, you create a Text section. You can type directly into a

text section, or copy and paste content from a spreadsheet. Copying and pasting from
a spreadsheet creates a new section for each spreadsheet row.

Topics:
¢ Adding a Text Section

¢ Editing a Text Section

See Also:

“Deleting Page Sections” and “Understanding Markup Syntax”

Adding a Text Section

To add a text section:
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1. Run the Websheet application. See “Running a Websheet”.
2.  From the Create menu, select New Section.
3. When prompted for the section type, select Text and click Next.
4. On Create Text Sections select either:
* Create single text section
¢ Create multiple text section from Spreadsheet
5. If you select Create single text section:
a. Sequence - Enter the section display sequence.
b. Title - Enter a section title.

c. Content - Enter text. To learn more about formatting text, see “Editing a Text
Section”.

d. Click Create Section.
6. If you select Create multiple text section from Spreadsheet:
a. First Row Contains Column Headings - Select this option if applicable.

b. Paste Spreadsheet Data - Paste a two column spreadsheet or other tab
delimited data. The first column must contain the section title and the second
column must contain the section content.

c. Click Create Section.
Tip:

You can also add a new section by selecting New Section on the Control
Panel.

Editing a Text Section
You can edit and format text sections using an intuitive WYSIWIG editor.

To edit a text section:
1. Run the Websheet as described in “Running a Websheet”.

2. Click the Edit icon that displays in the upper right of the section.
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View v Create » Edit = Data Grid « Administration v | Q, Search Websheet
Home » & s
¥ [Expand All] [Reset] o Edit Control Panel
4 D Home » New Section
D Frojects — Edit Sections
g D Systems -
3 New Page
~) AnyCo IT Department . Edit “| New Page as a Copy
"+ Edit Page
ustom solutions to clients in the services
Page Directory

and solutions

g itz buzinezs t anzulting zery

2 New Data Grid
The Edit Section page appears.
3. Edit the text in the field provided.
Tip:

To learn more about adding or embedding links, see “Understanding Markup
Syntax”.

4. To change the formatting, click the Expand Toolbar icon in the upper right corner.

AryCo Carp is a consulting firm founded in 2008, AnyCo Corp specializes in delivering custom 'Expand Toolbar
solutions to clients in the services industry, With a total of 125 emplovees, AnyCo Corp is
expanding its husiness to extend consulting services and solutions to clients across Morth
America.

This websheet summarizes the four major [[page: projects]] the T team is focusing on and the
[[page: systems]] required to run the department.

The various data grids, charts and reports are designed to provide a good overviews of [T
expenditure,

The following is & summary of the IT department's tasks at AnyCo Corpe

e Maintain the infrastructure such as hardware, netwoarks, desktops, printers,
servers, and telecommunication toals
« Provide dayto day [T supportto users across different deparments
s |dentify, evaluate and manage vendors for hardware, software, and all IT related v

o an e

body p -

The Toolbar appears. When you pass your cursor over an icon, a descriptive
tooltip displays.

5. To hide the toolbar, click the Collapse Toolbar icon.
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LHm alk 3 AP @EE®OS
B I U == X % I[= = EMWw == =E A~ A R
| Marmal = % - @ [ Source

Collapse Taclbar

AnwCo Corpis a consulting firm founded in 2008, AnyCo Corp specializes in delivering custom
solutions to clients in the semnvices industry. With a total of 125 employees, AnyCo Caorp is
expanding its husiness to extend consulting services and solutions to clients across Maorth
America.

This websheet summarizes the four major [page: projects]] the IT team is focusing on and the
[[nage: systerns]] required to run the depadment.

The various data grids, charts and reports are designed to provide a good overview of IT
expenditure.

The fallowing is a summary of the [T department's tasks at AnyCo Carp: w|

body p y

6. To save your changes, click Apply Changes.

About Navigation Sections

By creating a Navigation section, you can add dynamically generated navigation to
subordinate pages or page sections.

See Also:

“About Navigation Sections”, “Deleting Page Sections”, and “Editing Section
Titles and Display Order”

Adding a Navigation Section

To add a navigation section:
1. Run the Websheet application. See “Running a Websheet”.
2. From the Create menu, select New Section.
3. When prompted for the section type, select Navigation and click Next.
4. For Navigation Type:
a. Select either:
¢ Page Navigation - Creates navigation of all pages in the Websheet.
¢ Section Navigation - Creates navigation for all section on a page.
b. Click Next.
5. If you select Page Navigation, specify the following:
a. Sequence - Enter the section display sequence.
b. Title - Enter a section title.

c. Starting Page - Select the starting page from which to display hierarchical
navigation.
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d. Maximum Levels - Select the maximum number of levels (or tree depth) to
display.

e. Order Siblings - Select the order of siblings by column. If not defined, then the
siblings are sorted by the page name.

f.  Click Create Section.

6. If you select Section Navigation, specify the following:
a. Sequence - Enter the section display sequence.
b. Title - Enter a section title.

c. Click Create Section.

About Adding Data Grids

Data grids are sets of data displayed in rows and columns. Data grids store data in a
similar way to how spreadsheets store data. Once created, the structure can be
modified as needed over time.

Topics:

* About Data Grids

® Creating a Data Grid

¢ Copying a Data Grid

* Viewing and Editing a Data Grid

* Viewing the Data Grid Change History Log

® Deleting a Data Grid

See Also:

“About Adding and Editing Data Content” and “Understanding Markup
Syntax”

About Data Grids

You can define the structure of a data grid using column names, data sources, and
basic validations, or you can create a data grid by pasting spreadsheet data. Once
created, the structure can be modified as needed.

Users can alter the layout of report data by selecting columns or by applying filters,
highlighting, and sorting. Users can also define breaks, aggregations, group bys,
computations, and different charts. Additionally, users can create multiple variations
of a data grid and save them as named reports, for either public or private viewing.
You can also use the data from a data grid and include it as a chart or report within

any page.
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See Also:

“About Chart Sections”

Creating a Data Grid

You can create a data grid by either defining the structure (that is, the column names,
data sources, and basic validations), or by pasting in spreadsheet data. In addition to
the defined columns, the following standard columns are always included within each
data grid: owner, created by, created on, updated by, updated on, row order, and
annotation (files, notes, links, and tags).

Topics:
* Creating a Data Grid from Scratch
¢ C(Creating a Data Grid by Copying and Pasting Spreadsheet Data

Creating a Data Grid from Scratch

When you create a data grid from scratch you must define the column names,
datatypes, and basic values. Once you have created the basic structure, you can then
populate it with data.

To create a data grid from scratch:
1. Run the Websheet application. See “Running a Websheet”.
2.  From the Create menu, select New Data Grid.

Tip:

You can also select New Data Grid on the Control Panel.

3. When prompted for the section type, select From Scratch and click Next.
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Home * Data * Create Data Grid
G
Name * DOC_USER 01
Alias
Column Name Type Move
| String V| T
| String V| =
| String V| s
| String V| =
| String V| s
| String V| =
| String V| £
| String V| e

4. Specify the following;:
a. Name - Enter a data grid name.

b. Alias - Enter a data grid alias. Use this alias to link to this data grid within
other page sections. A data grid alias must be unique within an application.

c. Define the data grid structure by specifying the column name and data type.
To change the order, click the Up and Down arrow under Move.

To add more columns, click Add Column.

d. Click Create Data Grid.

The data grid appears.
5. To add data, click Add Row. See “Editing Data Grid Data”.
Creating a Data Grid by Copying and Pasting Spreadsheet Data
To create a data grid by copying and pasting spreadsheet data:
1. Run the Websheet application. See “Running a Websheet”.
2. From the Create menu, select New Data Grid.
Tip:

You can also select New Data Grid from the Create menu or the Control
Panel.

3. When prompted for the section type, select Copy and Paste and click Next.
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4. Specify the following:
a. Name - Enter a data grid name.
b. Alias - Enter a data grid alias. You can use this alias to link to this data grid
within page sections. A data grid alias must be unique within an application.
c. First Row Contains Column Headings - Select this option if applicable.
d. Paste Spreadsheet Data - Copy and paste the data you want to load from a
spreadsheet program.
e. Click Upload.
A data grid appears.
Copying a Data Grid
To copy a data grid:
1. Run the Websheet application. See “Running a Websheet”.
2. From the Data Grid menu, select an existing data grid.
The data grid appears.
3. From the Manage menu, select Copy.
4. Enter a new data grid name and click Copy.

Viewing and Editing a Data Grid

Once you create a data grid, you can view and edit it on the Data page.

Topics:

Accessing the Data Page

Editing Data Grid Data

Editing Data Grid Columns Manually

Editing Data Grid Rows Manually

Editing a Single Data Grid Row

Editing Data Grid Properties

Creating a Bookmark Link to a Data Grid
Tip:

Data grids display as an interactive report. To learn more about interactive
reports and using the Actions menu, see “Using Interactive Reports ” and
“Using the Actions Menu”.

Accessing the Data Page

To access the Data page:

1.

Run the Websheet application. See “Running a Websheet”.
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2.  From the Data Grid menu, select View All.

An interactive report appears displaying all data grids.
Tip:
If icons display, then click the View Report icon.

The Report view appears.

Data Grids |

Q- Go|[ 28 [ = || Actons~ | | Reset || viewsavedReports | [T
Name Embed Tag Allas Status Updated(v] Updated By
Prmojects ([ datagrid: 6702897 ]] 6702807 PRIVATE 92 minutes ago te
Planned Purchases [[ datagrid: 8158460 ]] 8158460 PRIVATE 93 minutes ago te

Systems Maintenance [[ datagrid: 8166770]] 8166770 PRIVATE 93 minutes ago te

By default, the Report view displays the data grid Name, Alias, Status, Created,
and Updated By columns. The Embed Tag column displays the syntax used to
include a link to the report or data grid from within a section of a page.

3. Select a data grid.

The data grid appears.
Home » Data ¥ Projects
Q- Go | Reports | 1. Primary Report | | Actions ~ | | Manage ~
Project(¥| Task Start Date End Date Status Assigned To Cost Budget Flles
V4 ;ig;ﬁ:;::tn Determine business rules ;EEAR ;g::l}()\n" Open Pam King $2,500.00  $4,000.00
V4 Timesheet Company rollout and training 25-MAR- 05DEC- Open Pam King $1,000.00  $1,500.00

Application 2010 2010

Toggling Check Boxes

When viewing a data grid, you can enable and disable check boxes. From the Manage
menu, select Toggle Check Boxes. By selecting this option, check boxes display to the
left of each row.
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Home » Data * Projects

Q- Go | Reports | 1. Primary Report V| | Actions ~ | | Manage ~

O Project(s) Task StartDate End Date Status AssignedTo  Cost  Budget Flles
o 7 ;ig;ﬁz;ﬁ; Eﬁteirmi"e business ;g;l\gm- ;gﬁ}w' Open  Pam King $2,500.00  $4,000.00

o 7/ ;gﬁg:ﬁ; S:i:‘iﬁ:"y olottand — 2SWAR- 9O5C Open  Pam King $1,000.00  $1,500.00

Editing Data Grid Data
To edit data grid data:

1. Run the Websheet application. See “Running a Websheet”.

2. From the Data Grid menu, select a data grid.

The data grid appears.

3. To add another row:

a. Click the Add Row button.

A form appears.

b. Edit the fields provided and click either Save or Save and Add Another.

Editing Data Grid Columns Manually

To manually edit data grid columns:

1. Run the Websheet application. See “Running a Websheet”.

2. From the Data Grid menu, select a data grid.

The data grid appears.

3. From the Manage Menu, select Columns.

Reports | 1. Primary Report

v| | Actions + | | Manage -

Start Date

15-MAR-
2010

20-MAR-
2010

25-MAR-
2010

07-APR-
2010

End Date Status
15-NOV-

2010 Open
30NOV-
2010 p
05-DEC-

2010 Open
07-APR-

2010 closed

Properties
Assigned To
Toggle Checkboxes
Pam Kin 32,5
g Columns
Rows
sidy Delete Data Grid
Pam King 31,0 Copy
History
John Watson $1,0b0:00 PIOUOU

The following submenu displays:

=

Links Tags

‘“ P Add
[colrtn] » | cotumn Properties
List of Values
Column Groups
Walidation

[Crelete Columns
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4.

Add - Adds a new column. Enables you to define all column properties such as
the column name, type, whether a value is required, list of values, default type,
and default text.

Column Properties - Editable properties include sequence, group, required
value, label, format, heading, width and height, column type, default text, list
of values, and help text.

List of Values - Enables you to restrict the values a user can enter. You
associate a list of values with a column on Column Properties.

Column Groups - Create a group and add columns to the group. Add / Edit
row page displays groups as a subsection under the Data region and lists
columns within the group. By using groups, you can control the Add / Edit
row page display.

Validation - Create a column validation and error message.

Delete Columns - Select columns to delete.

Select a submenu option and follow the on-screen instructions.

Editing Data Grid Rows Manually

To manually edit data grid rows:

1.

2.

Reports | 1. Primary Report

Start Date End Date

Run the Websheet application. See “Running a Websheet”.

From the Data Grid menu, select a data grid.

The data grid appears.

From the Manage Menu, select Rows.

15-MAR- 15-NOV-

2010 2010

20-MAR- 30-NOV-

2010 2010

25-MAR- 05-DEC-

2010 2010
07-APR- 07-APR-
2010 2010
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Properties

Status Assigned To Ce ) Links Tags
Toggle Checkboxes

Open Pam King

Columns »
Rows b A Y
Open \(J:Z'r:ez $6,0 'h Add Row
Sidy Delete Data Grid [Rows) | Set Column Values
Rows| | ==t 5 Sl
Open Pam King $1,0 copy Replace
Histaory Fill
closed John Watson $1,0borow PrUUTOU 7 — 71 Delete Rows

The following submenu displays:

Add row - Adds a new row.

Set Column Values - Set a predefined value for a column.

Replace - Search and replace row values.

Fill - Fill NULL column values with a column value from the above cell.

Delete Rows - Select rows to be deleted.

Select a submenu option and follow the on-screen instructions.
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Editing a Single Data Grid Row

To manually edit a single data grid row:
1. Run the Websheet application. See “Running a Websheet”.

2. From the Data Grid menu, select a data grid.

The data grid appears.

3. Locate the row to be edited and click the Edit Row icon.

Home » Data » Projects
Q- Go | Reports | 1. Primary Repart v| | Actions ~ | | Manage ~
Project Task Start Date End Date Status Assigned To Cost Budget
1{5 ;g;ﬁ:;ﬁ:tn Determine business rules ;;ngm ;;r::}ov Open Pam King $2,500.00  $4,000.00
e Cepoeandial JGUAR SOGopy T oo sioomao

The Add/Edit Row page appears.
4. Edit the appropriate rows and click Apply Changes.
Tip:

You can use the Actions region on the Add/Edit Row page to add a new row,
add annotations, view a history of changes, edit column properties and group,
delete columns, and create a list of values or a validation.

Adding Annotations to a Single Data Grid Row

To add annotations (that is, files, notes, links, and tags) to a single data grid row:
1. Run the Websheet application. See “Running a Websheet”.

2. From the Data Grid menu, select a data grid.

The data grid appears.

3. Locate the row to be edited and click the Edit Row icon.
The Add/Edit Row page appears.
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Home *

Data ¥

4 Report View

(¥) Data

Project
Task
Start Date

End Date
Status
Assigned To
Cost

Budget

4.

5.

Projects * Add/Edit Row

Delete Apply Changes

Row 10of 10

»

Timesheet Application
Determine business rules

15-MAR-2010

15-MOV-2010

Open
Pam King
$2,500.00

$4,000.00

From the Actions region, select one of the following:

e Add File

* Add Note
e Add Link
* Add Tags

Follow the on-screen instructions.

Actions
% Add Row

| 4 Add File
% Add Note
&3 Add Link

4 Add Tags

History

% Add Column
[I"| Column Properties
%= Column Groups

1 Delete Columns

*| List of Values

= Validation

See Also:

“Managing Annotations”

Displaying Annotation Columns in a Data Grid Report

To display annotation columns in a data grid report:

1.

Add annotations to the data grid report as described in “Adding Annotations to a

Single Data Grid Row”.
To include the columns in the data grid report:

a. View the data grid report.

b. Click the Actions menu and then Select Columns.

c. In the Select Columns region, move the columns (for example, Files, Notes,

Links, and Tags) to Display in Report.
d. Click Apply.

To ensure that all users can see the columns, developers can save the revised

layout as the default report.

To save a new default report:

2-22 End User's Guide



About Adding Data Grids

a. Click the Actions menu and select Save Report.

The Save Report Region appears.
b. InSave Report:
a. Save - Select As Default Report Settings.
b. Name - Enter a name for the report.
c. Description - Enter an optional description.
d. Click Apply.
Editing Data Grid Properties

You can change the name, alias, and description of a data grid on the Data Grid
Properties page.

To edit data grid properties:
1. Run the Websheet application. See “Running a Websheet”.

2. From the Data Grid menu, select a data grid.
The data grid appears.
3. From the Manage menu, click Properties.

The Data Grid Properties page appears.
4. Edit the fields provided and click Apply.

Creating a Bookmark Link to a Data Grid

To bookmark directly to a data grid or a row, use the following syntax:

ws?p=100000: DG <data grid alias>
ws?p=100000: DG <data grid alias>:: RONID:<data grid row | D>

Thedata grid row | Disan ID column value of the APEX$_W5_ROWS table.

To get a link to a specific data grid row:
1. Run the data grid.
2. Click the Edit Row icon.

3. Note the URL in the browser.

Viewing the Data Grid Change History Log

The View Change History log displays a report of data grid changes. This report lists
the row, column name, old value, new value, user who authored the change, and how
long ago the change occurred.

To view a history of data grid changes:
1. Run the Websheet application. See “Running a Websheet”.

2. From the Data Grid menu, select a data grid.

The data grid appears.
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3. From the Manage menu, select History.

Deleting a Data Grid
To delete a data grid:
1. Run the Websheet application. See “Running a Websheet”.

2. From the Data Grid menu, select a data grid.
The data grid appears.

3. From the Manage menu, select Delete Data Grid.

4. Confirm your selection and click Delete.

About Adding and Editing Data Content

This section describes how to add and edit data content.

Topics:
¢ About Available Data Sources
¢ About Enabling Support for Creating Data Reports

® About Incorporating Data into Websheet Pages

About Available Data Sources

Websheets can include data sources. Once defined, you can incorporate these data

sources into Websheet page sections. Websheets can include the following data
sources:

e Data Grids - Data grids are highly customizable, editable tabular reports. Data
grids enable you to maintain data within the Websheet that is stored within the
Oracle Database. See “About Adding Data Grids”.

® Reports - Reports are queries defined against tables or views that exist within your
Oracle Database. See “About Adding Data Reports”.
About Enabling Support for Creating Data Reports

To define a data report, your Websheet developer must enable the Allow SQL and

PL/SQL attribute on the Application Properties page. By default, this attribute is
disabled.

Tip:

Only a Websheet application developer can edit the Allow SQL and PL/SQL
attribute on the Application Properties page. To learn more, see "Editing
Websheet Application Properties" in Oracle Application Express Application
Builder User’s Guide.

About Incorporating Data into Websheet Pages

Data grids and data reports can be incorporated into page sections in the following
ways:
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Within a data section. See “About Adding Data Reports”.
Within a chart section. See “Adding a Chart Section”.
Linking to a data grid. See “Linking to a Data Grid”.

Include a single value or tabular results of queries See “Using SQL and SQLVALUE
Syntax”.

About Adding Data Reports

Data reports are contributor defined queries on tables or views within the underlying
Oracle Database.

Tip:

Before you can add a data report, your Websheet application developer must
enable the Allow SQL and PL/SQL attribute on the Websheet properties page.
By default, this attribute is disabled. To learn more, see "Editing Websheet
Application Properties" in Oracle Application Express Application Builder User’s
Guide.

Topics:

About Data Reports

Creating a Data Report

Viewing and Modifying a Data Report
Deleting a Data Report

Managing Uploaded Files and Images

See Also:

“About Adding and Editing Data Content” and “Understanding Markup
Syntax”

About Data Reports

Data reports, unlike data grids, are query-only and based on existing data from the
Oracle Database. You can specify the table or view name and retrieve all columns or
write a SQL statement to retrieve the required data.

Users can alter the layout of report data by selecting columns or by applying filters,
highlighting, and sorting. Users can also define breaks, aggregations, group by,
computations, and different charts. Additionally, users can create multiple variations
of a data grid and save them as named reports, for either public or private viewing.
You can also use the data from a data report and include it as a chart or report within

any page.

See Also:

“About Data Sections” and “About Chart Sections”
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Creating a Data Report

You can create a data report by either simply entering the table or view name, or by
providing a SQL query.

To create a data report:

1.

2.

4.

Run the Websheet as described in “Running a Websheet”.

From the Report menu, select New Report.

Tip:

You can also select New Report on the Control Panel.

The Create Report page appears.

For Report Source, identify how to develop your source. Options include:

a. Table - Select Table and enter the following:

Table or View Name - Select the name of the table or view on which to
base the report.

Report Name - Enter the name of the report.

Report Alias - Enter a report alias. A Report alias is used for linking to the
Report within page sections. A Report alias must be unique within an
application.

b. SQL Query - Select SQL Query and enter the following:

Report Name - Enter the name of the report.

Report Alias - Enter a report alias. A Report alias is used for linking to the
Report within page sections. A Report alias must be unique within a
Websheet.

Query - Enter the SQL query that defines your report.

c. Click Next.

Confirm your selections and click Create Report.

Viewing and Modifying a Data Report

To view or modify a data report:

1.

2.
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Run the Websheet as described in “Running a Websheet”.

From the Report menu, select View AlL

The Report page appears.

Select the report.
The report appears.

To edit report attributes:
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¢ From the Manage menu, click Edit Attributes.
The Report Attributes page appears.

¢ Edit the attributes and click Apply Changes.
5. To edit the report query:

¢ From the Manage menu, click Edit Query.
The Report Query page appears.

* To save your changes, click Apply Changes.

Deleting a Data Report

To delete a data report:
1. Run the Websheet as described in “Running a Websheet”.

2. From the Report menu, select the report.

The report appears.

3. Select the report.
The report appears.

4. From the Manage menu, click Edit Attributes.
The Report Attributes page appears.

5. Click Delete.

About Data Sections

You can create data sections based upon a data grid or report.

Topics:
¢ Adding a Data Section to a Page

¢ Editing a Data Section

See Also:

“About Adding and Editing Data Content”

Adding a Data Section to a Page

Once you create a data grid or report, you add it to a page by adding a data section.

See Also:

“About Adding Data Grids” and “About Adding Data Reports”

To add a data section:
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1. Run the Websheet application. See “Running a Websheet”.

2.  From the Create menu, select New Section.

3. When prompted for the section type, select Data and click Next.
4. Specify the following:

a. Data Section Source - Select either Data Grid or Report.

b. Display Sequence - Enter the section display sequence.

c. Data Grid/Report - Select the data grid or report to be used to display the
data section.

d. Report Settings to Use - For the selected data grid or report, select the report
settings to use. This selection enables you to filter the rows and columns you
want to display and set the columns to display.

Tip:
If you do not have a saved report with the settings you need, create it now
before adding the section.

e. Title - Enter the section title.

f. Include - Select whether to add the following;:

* Add Row (available if Data Section Source is data grid)
¢ Edit Row(available if Data Section Source is data grid)
¢ Search Field

g. Style - Choose a user interface style.

h. Click Next.

5. Click Create Section.
Editing a Data Section

Once you have added a data report to a page, you can change the section sequence,
title, and user interface style.

To edit a data section:

1.

2.

3.

4.

Run the Websheet as described in “Running a Websheet”.

Click the Edit icon that displays in the upper right of the section.

The Edit Section page appears.

Edit the fields provided. See item Help for more details.

To save your changes, click Apply Changes.

About Chart Sections

You can create inline charts based upon a data grid or report.
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Topics:

¢ Adding a Chart Section

¢ Editing a Chart Section

See Also:

“About Adding and Editing Data Content”

Adding a Chart Section

To add a chart section:

1.

2.

Run the Websheet application. See “Running a Websheet”.

Create a data grid or report. See “About Adding Data Grids” and “About Adding
Data Reports”.

From the Create menu, select New Section.
When prompted for the section type, select Chart and click Next.
On Select Chart Type:
a. Select one of the following:
¢ Column
* Horizontal Bar
¢ Pie
* Line
b. Click Next.
Specify the following;:
a. Display Sequence - Enter the section display sequence.
b. Data Grid - Select a data grid.

c. Report Settings to Use - For the selected data grid or report, select the report
settings to use. Use this option to filter the rows and columns you want to
display.

If you do not have a saved report with the settings you need, then create it
now before adding the section.

d. Section Title - Enter the section title.
e. Click Next.
Specify the following;:

a. Chart Label - Select the column to be used as the Label.

In Axis Title for Label, enter the title to display on the axis associated with the
column selected for Label.
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8.

e.

Chart Value - Select the column to be used as the Value. If your function is a
COUNT, a Value does not need to be selected.

In Axis Title for Value, enter the title to display on the axis associated with the
column selected for Value.

Function - Select a function to be performed on the column selected for Value.

Sort - Select the chart sort direction.

Check Enable 3D to display the chart in 3D.

Click Next.

On the summary page, confirm your selections and click Create Section.

Editing a Chart Section

To edit a chart section:

1.

2.

3.

4.

Topics:

Run the Websheet application. See “Running a Websheet”.

Click the Edit icon that displays in the upper right of the section.

The Edit Section page appears.

Edit the fields provided. See item Help for more details.

Click Apply Changes.

About PL/SQL Sections

Users with PL/SQL knowledge can create PL/SQL sections and write their own code
against the associated schema.

Tip:
PL/SQL sections are only available if the Websheet application developer has
enabled the Allow SQL and PL/SQL attribute on the Websheet Properties

page. To learn more, see "Editing Websheet Properties” in Oracle Application
Express Application Builder User’s Guide.

e Adding a PL/SQL Section

e Editing a PL/SQL Section

See Also:

“Deleting Page Sections”

Adding a PL/SQL Section
To add a PL/SQL section:

1.
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6.

Run the Websheet application. See “Running a Websheet”.
From the Create menu, select New Section.
Tip:

You can also select New Section on the Control Panel. See “About the Control
Panel”.

When prompted for the section type, select PL/SQL and click Next.
Specify the following;:

a. Sequence - Enter the section display sequence.

b. Title - Enter the section title.

c. Enter PLSQL - Enter a PL/SQL anonymous block of code.

d. If applicable, select Do not validate PL/SQL code (parse PL/SQL code at
runtime only). Select this option to create the section even when an error
occurs. Use this option to create the section and then debug it later.

Tip:
To view an example, click PL/SQL Example.

Click Create Section.

Editing a PL/SQL Section
To edit a PL/SQL section:

1.

2.

4.

Run the Websheet as described in “Running a Websheet”.

Click the Edit icon that displays in the upper right of the section.
The Edit Section page appears.

Edit the following;:

a. Sequence - Enter the section display sequence.

b. Title - Enter the section title.

c. Enter PL/SQL - Enter a PL/SQL anonymous block of code.

To save your changes, click Apply Changes.

Understanding Markup Syntax

This section describes syntax for adding links to Websheet pages, page sections,
external URLSs, data grids, or for including SQL or SQLVALUE syntax.

Tip:

A Help button displays in the upper right corner of each Websheet page. The
Help page, Markup Syntax, lists all the different syntax options described in
this section.
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Topics:

¢ Linking to a Page

¢ Linking to a Section

¢ Linking to External URLs

¢ Linking to a Data Grid

¢ Using SQL and SQLVALUE Syntax

¢  About Advanced Data Grid Queries Rules

See Also:

“Managing Uploaded Files and Images”

Linking to a Page

To include links in page sections to other pages in a Websheet, use the syntax
described below. If the page exists, a link displays. If the page does not exist, a link to
create the page displays. Note that the use of the page: identifier is optional.

Syntax:

[[ page: <page alias> | <link name> ]]
[[ <page alias> | <link name> ]]
Syntax Example:

[[page: hone]]

[[nypage | My Page]]

In Context Example:

One of the nost colorful fish is the [[ clowfish | Cown fish]].

Linking to a Section

To include links to a page section, use the syntax below. If the section exists, a link
displays. If the section does not exist, a link to create the section displays. Note that if
the section is not prefaced by a page, it is assumed the section is on the current page.

Syntax:
[[ section: <page alias> . <page section> | <link name> ]]

[[ section: <page section> | <link name> ]]

Syntax Example Linking Within the Current Page:

[[section: clownfish | Cown Fish]]

Syntax Example Linking to a Different Page:

[[section: fish.clownfish | Cown Fish]]
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In Context Example:

One of the nost colorful fish is the [[ section: clownfish | Cown fish]].
Visit or fish page to see the [[ section: fish . clownfish | Qown fish]], also
known as Neno.

Linking to External URLs

To include links to external URLs in page sections, use the syntax below. Note that the
use of the ur | : identifier is optional. To have the link open in a new browser window,
use the popup prefix.

Syntax:

[[ url: <url>] <link name> ]]
[ popupurl: <url> | <link nanme> ]]
[[ <url>] <link name> ]]

Syntax Example:

[[url: http://ww.conpany.com store | conmmpanystore]]
[[popupurl: http://ww. conpany.conistore | conmpanystore]]
[[http://ww. sear chengi ne. com | searchengi ne]]
[[http://ww. sear chengi ne.com ]]

In Context Example:

You can buy Conpany software on the [[http://ww. conmpany. com store | Company
Store]] website.

Linking to a Data Grid

To include links to data grids within page sections, use the syntax below. You can use
these links to view the data grid or to create new data. Note that data grid can be one
or two words.

Syntax:

[[ data grid: <datagrid alias | <link name> ]]

[[ datagrid: <datagrid alias | <link name> ]]

[[ datagrid: <datagrid alias . <saved report name (may not be private)> | <link
name> ]]

Syntax Example:

[[ data grid: todo list | To Do List ]]
[[ data grid: todo list . open todo itens | To Do List ]]
[[ datagrid: todo list | To Do List ]]

In Context Example:

Pl ease review the [[ data grid: todo list | To Do List ]] and ensure your tasks
can be acconplished by Friday.

Using SQL and SQLVALUE Syntax

By using SQL or SQLVALUE syntax, you can include single value and tabular results of
queries against data grids or tables and views within sections of a page. The
SQLVALUE tag displays the first column of the first row returned by the SQL query.
Use this syntax to embed data within a sentence (for example: There are currently 5
types of cats.). For tabular results, use the SQL tag. Using SQL tag produces a

Using Websheets 2-33



Understanding Markup Syntax

searchable report. However, you can disable the search option by using the NOSEARCH
syntax.

When working with data grids, there are a few more options (shown under Syntax)
and a few more rules. Basic rules when writing a data grid query include:

¢ Enclose the data grid name or data grid alias with braces. For example:

{Cat Facts}

* Enclose the data grid column names with double quotation marks. For example:

"Type of Cat"

To learn more about advanced rules, see “About Advanced Data Grid Queries Rules”.

Syntax for Queries Against Tables and Views:

[[sql: <select statenment> ]]

[[sql: <select statenment | |imt="<maxi mumrows>" nosearch style="<style
nunber >" 1]

[[sql val ue: <select statement> ]]

Syntax for Data Grid Queries:

[[sql: <select statement> ]]

[[sql: <select statement | |imt="<maxi mumrows>" nosearch style="<style
nunmber >" edit_row add_row show_sql ]]

[[sql val ue: <sel ect statement> ]]

[[sql val ue: <sel ect statenment> | show_sql ]]

In Context SQL Tag Syntax Examples:

[[sql: select enane "Enpl oyee Name", sal "Salary" fromenp order by sal desc |
limt="10" style="2"]].
[[sql: select "Type of Cat",
"Esti mated Popul ation",
"Largest Threats",
"Top Speed",
"Scientific Name",
"I UCN Status",
"\\ei ght ",
" Study Date"
from{Cat Facts} | add_row edit_row ]]

In Context SQLVALUE Tag Syntax Examples:

We have [[sql value: select count(*) fromenp]] enployees in our database,
[[sql val ue: select count(*) fromenp where deptno=10 ]] work in department 10.
We are currently tracking [[sql value: select count(*) from{Cat Facts} ]]
types of cats.

About Advanced Data Grid Queries Rules

Advanced data grid query rules include:

¢ The query must reference the data grid only once to include an edit or add row link
(that is, you cannot join the data grid to itself within the query).

* The first column must be the primary key of the data grid to include an edit row
link (that is, the column that uniquely identifies the row of data). If the "edit_row"
option is included and the query has a single select statement, the primary key
column is included automatically. If the query contains multiple select statements,
you can use the " APXWS_DATA_GRI D_PK" substitution (always enclosed with
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double quotation marks) as the first column in the SELECT statement to include the
primary key to include an edit row link.

* Report column names are the column name from the data grid, but can be modified
using standard SQL column aliasing syntax. For example, the following displays
the data from the M ni num Nunber column but the heading displays as M n:

sel ect "M ni mum Nunber” "M n" from...

¢ If a column name is longer than 30 characters, you only include the first 30
characters as the name. For example, use:

"% of Estinmated Lions per Region"

Instead of:

"% of Estimated Lions per Region"

e To display the query that is executed, include the "show_sql " option. By including
this option, the query displays above the included report. Although this is a good
approach for debugging, Oracle does not recommend "show_sql " for a production
application.

Managing Annotations

You can add commentary and additional details to a web page by adding annotations.
Annotations can be in the form of uploaded files, notes, links, and tags. Annotations
can be added to both pages and data grid records.

Topics:

* Managing Uploaded Files and Images
¢ Adding Tags

¢ Adding Notes

* Viewing and Deleting Annotations

See Also:

“Adding Annotations to a Single Data Grid Row”

Managing Uploaded Files and Images

You can upload files and images to a Websheet page using the Files region. Once
uploaded, you can display uploaded images within a page section or embed
download links to files.

Topics:

¢ Uploading Files and Images

¢ Including a Download Link in a Page Section
¢ Displaying an Uploaded Image Inline

e Editing or Deleting Uploaded Files
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Uploading Files and Images

To upload files and images to a Websheet:
1. Login to and run the Websheet. See “Running a Websheet”.

2. Under Files on the right side of the page, click the Add File icon.

Files + >
Resources.xlsy {h .
Add File

logo.gif &

3.  On the Add File page:

a. File - Browse to locate the file to upload. Once uploaded, the file is associated
with the current page. You can reference an uploaded file in any page using
the image or file syntax. See “Displaying an Uploaded Image Inline” or online
Help, Markup Syntax.

b. Alias - A file alias enables you to embed download links or image links
within page sections. A file alias must be unique within an application.

c. Description - Enter descriptive text to describe the file.

4. Click Add File.

Including a Download Link in a Page Section

You can embed a download link within a page section to uploaded files using the
following syntax.

Syntax:

[[ file: <file nane > | < link name > ]]
[[ file: <file alias > | < link name > ]]

Syntax Examples:
[[file: myfile ]]

[[file: myfile.xls ]]
[[file: nyfile | My File ]]

File Markup Example:

This [[file: parts0l.xls | spreadsheet ]] documents our part nunbers.

Displaying an Uploaded Image Inline

After you upload an image, you can display it within any page section of an
application by embedding a download link using the following syntax. You can
reference an uploaded image using the image name or image alias.

Images defined for the current page are used before images associated with other
pages. If image names are ambiguous, the most recently created image displays.
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Syntax:

[[ image: < file name > | < properties > ]]
[[ image: < file alias > | < properties > ]]

Syntax Examples:

[[image: nyimage ]]
[[i mage: thei magenane.jpg ]]
[[image: nyimage | w dth="600" alt="ny imge" ]]

Example:

This diagram [[image: diagranl]] illustrates the work flow.

Editing or Deleting Uploaded Files
To edit details or delete uploaded files:

1. Login to and run the Websheet. See “Running a Websheet”.

2. In the Files region, click the Edit File icon.
The Details page appears.

3. To edit file details:
a. Edit the fields provided. See item Help for more details.
b. To accept your changes, click Apply Changes.
4. To delete a file:
a. Click Delete.
b. To accept your changes, click OK.
Adding Tags

Tags facilitate keyword searching within a Websheet.

Topics:

¢ Adding Tags

e Editing Existing Tags

Adding Tags

To add tags to a Websheet page:

1. Login to and run the Websheet. See “Running a Websheet”.

2. Under Tags on the right side of the page, click the Add Tag icon.

Tags + >
Sarmple tag. h :
PE

3. Enter tags in the field provided. Separate multiple tags with a comma.
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4.

Click Apply Changes.

Editing Existing Tags

To edit existing tags:

1.

2.

Adding Notes

Log in to and run the Websheet. See “Running a Websheet”.

In the Tags region, click the Edit Tag icon.
The Details page appears.

Edit the tags and click Apply Changes.

Notes record user comments.

Topics:

¢ Adding Notes

e Editing or Deleting Existing Notes

Adding Notes
To add notes to a Websheet page:

1.

2.

3.

4.

Log in to and run the Websheet. See “Running a Websheet”.

Under Notes on the right side of the page, click the Add Note icon.

Notes + >

The Sample Websh.

Enter text in the field provided.

Click Add Note.

Editing or Deleting Existing Notes

To edit or delete existing notes:

1.

2.
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Viewing and Deleting Annotations

You can view and delete all Websheet annotations on the Annotations page.
Annotations include uploaded files, notes, links, and tags that were either added to a
Websheet page or to a specific row in a data grid.

Topics:

® Accessing the Annotations Page

® Deleting Annotations

Accessing the Annotations Page

To access the Annotations page:

1.

2.

Log in to and run the Websheet. See “Running a Websheet”.

From the View menu, select Annotations.

The Annotations page appears.

Home »  Annotations

All Files Hotes Links Tags Tag Clousd
Q- Go H = Actions ~ Reset
Sofhware updates The Budget Review The chart shows The Sample Ifthe Annual Budget
chart s systermn-wi ‘Wehsheet Appli colu
The Total Flanned Ifyou add a row Costs Resources Tasks
Purchas under Pu

The Annotations page displays as an interactive report. To learn more about
interactive reports, see “Using Interactive Reports ” and “Using the Actions
Menu”.

To view specific type of annotation, click the Files, Notes, Links, Tags, or Tag
Cloud tabs.

Deleting Annotations

To delete uploaded files, notes, link, or tags:

1.

2.

Log in to and run the Websheet. See “Running a Websheet”.

From the View menu, select Annotations.

The Annotations page appears.
Select an annotation type by clicking the appropriate tab at the top of the page.

If not selected, click the View Report icon.
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5. Click the appropriate tab: Files, Notes, Links, Tags, or Tag Cloud.

6. Select the annotations to delete.

Home » Annotations * Files

| Al | Files | Notes | Links | Tags | TagCloud |

Q- Gol| 28| = | | Actions - (Sl Dekete Checked

Flle Name Allas Attributes Page Data Grid Created(>] Created By Flle Size

é [ Besources.xlsx Resources.xlsx - Home - z:;ohours terri aKB

& systems. jpg systems.jpg - Systems - i:;ohours teri 1MKB

F [0 logo.qi logo. gif - Home - z:;ohours temi 116KB
Planned 23 hours

o [0 vendors.txt vendors. txt - Purchases - . terri 164

Review g

7. Click Delete Checked.

Managing Websheet Applications

This section describes how to change your Websheet password, email a Websheet to
another user, and print a Websheet.

Topics:
¢ Changing Your Websheet Password
¢ Emailing a Websheet Page

¢ Printing a Websheet Page

Changing Your Websheet Password
To change your Websheet password:

1. Login to and run the Websheet. See “Running a Websheet”.

2. From the Administration menu, select Change My Password.

The Change Password page appears.

3. Follow the on-screen instructions and click Change Password.

Emailing a Websheet Page
To email a Websheet page:

1. Login to and run the Websheet. See “Running a Websheet”.
2. Locate the page you want to email.

3. Click the Email icon above the Control Panel.
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‘ Q, Search Websheet |

& = O

Edit Control Panel E-mail v,

= New Section
_+ Edit Sections
4. On the Email Page:
a. To - Enter the target email address.
b. Subject - Enter a description of this email.

c. Body - Enter the email content you want to include along with the Websheet
page link.

5. Click Send.

An email link to the currently selected page is automatically included in your email
message.

See Also:

"Configuring Email" in Oracle Application Express Administration Guide

Printing a Websheet Page

To print a Websheet in printer-friendly mode:
1. Login to and run the Websheet. See “Running a Websheet”.

2. Click the Print icon above the Control Panel.

| Q, Search Websheet |

& =
0
[

Edit Control Panel rint

= New Section

_+ Edit Sections
The page displays in printer-friendly mode.

3. Print the page.

Viewing Websheets

Use the options on the View menu to access presentation mode, view a page directory,
access a page history, and view an application directory.

Using Websheets 2-41



Viewing Websheets

Topics:

* About Presentation Mode

* Viewing the Page Directory
* Viewing Page History

* Viewing the Websheet Directory

See Also:

“Managing Annotations” and “About Adding Data Grids”

About Presentation Mode

Presentation mode enables a single Websheet page to be viewed as a presentation.
Each page section displays one at a time as a slide. Users can navigate between
sections by using the right and left arrow keys, by using the right and left arrow
controls on the top right of the page, or by entering a section number to quickly jump
to a specific section.

To view a Websheet in presentation mode, click the Presentation icon on the far right
side of the page.

| Q, Search Websheet

& = @
“rEdit c Control Panel '{Presenta@

& New Section

_+ Edit Sections

In Presentation mode, each page section displays as a separate page.
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o > s FIEETEDEY

Systems Overview

The IT team at AnyCo Corp manages all hardware and software. This includes maintaining
hardware resources, networks, applying software updates, regular backups etc. The overall
cost incurred is computed considering the cost of purchase along with maintenance cost and

Use the navigation bar on the upper right of the page to scroll forward and backward
from section to section. To exit Presentation mode, click the Exit icon or press ESC.

Viewing the Page Directory

Use the Page Directory to view all pages in the current Websheet. Each Websheet can
contain any number of pages.

To access the Page Directory:
1. Login to and run the Websheet. See “Running a Websheet”.

2. From the View menu, select Page Directory.

The Page Directory displays as an interactive report. To learn more about
interactive reports and using the Actions menu, see “Using Interactive Reports ”
and “Using the Actions Menu”.

By default, the Page Directory displays in icon view.

Home » Page » Page Directory

| Page Directory | Application Directory |

|Q' |Go| e §||ncﬁonsv|
Hame Flanned Purchases Projects Systems

{b Review
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One page in each Websheet is designated as the home page. The home page is the
starting page that displays when you run the Websheet. In Icon view, the home
page displays as a page with orange outline of home.

3. To view the page as a report, click the View Report icon.

By default, Report view displays the following columns: Name, Doc Type,
Created, Created By, Updated On, Updated By, Parent Page, and Grand Parent
Page.

Viewing Page History
Use the Page History to view a log of all changes to the current page.

To view the Page History:
1. Login to and run the Websheet. See “Running a Websheet”.
2. Select a page.

3. From the View menu, select Page History.
The Page History displays as an interactive report.

A Search bar displays at the top of the page. Available controls include:

* Select columns to search - Resembles a magnifying glass. Click this icon to
narrow your search. To search all columns, select All Columns.

e Text area - Enter case insensitive search criteria (wildcard characters are
implied) to search for a page group by name and then click Go.

* Go button - Executes a search or applies a filter.
* View Icons - Displays each Websheet as a large icon.
* View Report - Displays each Websheet as a line in a report.

* Actions menu - Use the Actions menu to customize the report view. See
“Using the Actions Menu”.

4. To view changes in a Calendar format, click Calendar.

Viewing the Websheet Directory
Use the Websheet Directory to navigate to another Websheet application.
To access the Websheet Directory:

1. Login to and run the Websheet. See “Running a Websheet”.

2. From the View menu, select Websheet Directory.

A Search bar displays at the top of the page. Available controls include:

* Select columns to search - Resembles a magnifying glass. Click this icon to
narrow your search. To search all columns, select All Columns.

e Text area - Enter case insensitive search criteria (wildcard characters are
implied) to search for a page group by name and then click Go.

* Go button - Executes a search or applies a filter.
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* View Icons - Displays each Websheet as a large icon.
* View Report - Displays each Websheet as a line in a report.

* Actions menu - Use the Actions menu to customize the report view. See
“Using the Actions Menu”.

3. To view a Websheet:
¢ InIcon view, click the appropriate icon.

¢ In Report view, click the Run icon in the Actions column.
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Using Interactive Reports

An Oracle Application Express database application is a collection of pages linked
together using tabs, buttons, or hypertext links. This section describes how to use
Oracle Application Express interactive reports.

Topics:

¢ Running an Interactive Report

* What is an Interactive Report?

¢ Using the Column Heading Menu
¢ Using the Search Bar

* Using the Actions Menu

See Also:

"Creating Reports" in Oracle Application Express Application Builder User's
Guide.

Running an Interactive Report

An interactive report is contained in a page within a database application. To run an
interactive report you must log into the database application and then navigate to the
report page. To accomplish this, you need the URL for the database application and
the account credentials (that is, a username and password).

To run an interactive report:

1. Click the supplied URL, or enter it in your browser's Address field.
A Login page appears.

2.  On the Login page:
a. Username - Enter your username.
b. Password - Enter your password.

c. Click Login.

The interactive report appears.
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What is an Interactive Report?

What is an Interactive Report?

ProjectE]

APER
Erwironment
Configuration

APEX
Erwironment
Configuration

APEX
Erwironment
Configuration

APEX
Erwironment
Configuration

Oracle Application Express includes two main report types, an interactive report and a
classic report. The main difference between these two report types is that interactive
reports enable the user to customize the appearance of the data through searching,
filtering, sorting, column selection, highlighting, and other data manipulations.

About Interactive Reports

The following is an example of an interactive report.

Go Actions - | Create |
Task Name Start Date End Date Status Assigned To Cost Budget

|dentify server 27-MAY-12 28-MAY-12 Closed John Watson 100 200
requirements
Deterrmine Web listener 28-MAY-12 28-MAY-12 Closed Jarnes Cassidy 100 100
configuration(s)
Specify security 29-MAY-12 I1-MAY-12 Cloged Johin Watson 200 300
authentication
scheme(s)
Select servers for 29-MAY-12 03-JUM-12 Closed Jarnes Cassidy 200 GO0
Development, Test,
Production

Interactive reports enable end users to create highly customized reports. Users can
alter the report layout by hiding or exposing specific columns and applying filters,
highlighting, and sorting. They can also define breaks, aggregations, charts, group
data, and add their own computations. Once customized, the report can be saved as
either a private or public report. Most interactive reports include a search bar, Actions
menu, Column Heading menu, and edit icons in the first column of each row.

In contrast, classic reports support general keyword search capability, the ability to
specify the number of rows that display, and basic column sorting.

Using the Search Bar

q-

Go | Reports | 1. Primary Repart v | = Actions ~

A search bar displays at the top of most interactive reports and may include the
following features:

¢ Select columns to search icon - Resembles a magnifying glass. Click this icon to
narrow your search to specific columns. To search all columns, select All Columns.
See “Using the Select Columns To Search Icon”.

* Text area - Enter case insensitive search criteria (wildcard characters are implied)
and then click Go.

¢ Go button - Executes a search.
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¢ Reports - Displays alternate default and saved private, or public reports. See
“Saving an Interactive Report”.

* View icons - Switches between an icon, report and detail view of the default report
(if enabled). May also include Chart and Group By View (if defined).

® Actions menu - Use the Actions menu to customize an interactive report. See
“Using the Actions Menu”.

Tip:

Developers can customize what displays on the Search bar. To learn more, see
"Customizing the Interactive Search Bar" in Oracle Application Express
Application Builder User’s Guide.

Using the Select Columns To Search Icon

The Select columns to search icon displays to the left of the search bar. Clicking this
icon displays a listing of all columns in the current report.

To search specific columns:

1. Click the Select columns to search icon and select a column.

= r,r"()ostover&ﬁﬂﬂﬂ T

Project Task Name Start Date) End Date Status Assigned To Cost
& Maintain Suppoart HF software upgrades 31-MAY-12 2E-JUL-12 Cn-Hald Fam King 2,000
Systerns
& Maintain Support Apply Billing Systermn H-MAY-12 A0-JUL-12 Cn-Hold Fuss Sanders 9,500
Systems updates
& Email Integration  Complete plan O7-JUk-12 13-JUL-12 Closed Mark Mile 3,000

2. Enter keywords in the Text area and click Go.
3. To disable the filter, select the Enable/Disable Filter check box.

4. To delete the filter, click the Remove Filter icon.

See Also:

“Selecting Columns to Display”

Using the Column Heading Menu

Clicking a column heading in an interactive report exposes the Column Heading
menu. Positioning the cursor over each icon displays a tooltip that describes its
function.
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Q. Go Actions
Project Task Name Start Date
& % ® B E @ 01-JAN-12
_/ Jpgrades 01-JAR-12
4 P D1-JAN-12
4 ah listener 02-JAN-12
Biug Tracker Ll =1}
Convert Excel Spreadshect I
& | 03-JAN-12

Discussion Forum

Email Integration

Employee Satizfaction Survey

Environment Configuration

Farms Conversion

Load Packaged Applicstions

Mairtain Support Sy stems

Create

End Date

02-JAN-12
26-FEB-12
01-MAR-12

02-JAN-12

05-JAN-12

Column Heading menu options include:

Sort Ascending - Sorts the report by the column in ascending order.

Status

Closed
On-Hald
On-Hald

Closed

Closed

Assigned To

JohnYatson
Pam King
Russ Sanders

James Cassidy

JohnYatson

100

a000

3500

100

200

Buiget

200
Ta00
7000

100

300

Sort Descending - Sorts the report by the column in descending order.

Hide Column - Hides the column. Not all columns can be hidden. If a column
cannot be hidden, the Hide Column icon does not display.

Control Break - Creates a break group on the column. This pulls the column out of
the report as a master record. See “Creating a Control Break”.

Column Information - Displays help text about the column, if available.

Text Area - Used to enter a case insensitive search criteria. Entering a value reduces
the list of values at the bottom of the menu. You can then select a value from the
bottom. The selected value will be created as a filter using either the equal sign (=)
or cont ai ns depending on the List of Values Column Filter Type.

Using the Actions Menu

You can customize an interactive report by selecting options on the Actions menu.

Tip:

Not all options described in this section are available on every Actions menu.

Developers can customize what options appear. To learn more, see
"Customizing the Interactive Search Bar" in Oracle Application Express

Application Builder User’s

Topics:
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Creating a Control Break

Adding Highlighting

Computing Columns

Aggregating a Column

Creating a Chart from the Actions Menu

Grouping Columns

Executing a Flashback Query

Saving an Interactive

Resetting a Report

Report

Downloading a Report

Subscribing to Emailed Reports

About the Actions Menu

Project

& APEX
Enviranment
Configuration

@ haintain
Support
Systems

I Iaintain
Support
Systems

I APEX
Enviranment
Configuration

The Actions menu appears to the right of the Go button on the Search bar. Use this
menu to customize an interactive report.

Go | Repoarts

Task Name  Start Date(=

|dentify server 27-WAY-12
reguirements

HR software 27-MAY-12
upgrades

Apply Billing 27-MAY-12
Systern
updates

Deterrnine WWeb  28-WMAY-12
listener
configuration(s)

1. Primary Report
End Date Status
28-MAY-12 Closed
22-JUL12 On-Hald
26-JUL12 Orn-Hold
28-MAY-12 Closed

]

¥ |

| | Actions » |

Assigned To

John Watson

Parn King

Russ Sanders

James Cassidy

The Actions menu contains the following options:

Select Columns

Co!

Filter
Rows Per Page »

Format »
8 Flashback

Save Report
g Reset

Help

Dawnload

Subscription

Select Columns specifies which columns to display and in what order. See

“Selecting Columns to Display”.

Filter focuses the report by adding or modifying the filter clause on the query. See

“Adding a Filter”.

Rows Per Page determines how many rows display in the current report. See
“Specifying Rows Per Page”.

Format contains the following submenu:

* Sort - Changes the columns to sort on and determines whether to sort in
ascending or descending order. See “Selecting Column Sort Order”.
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¢ Control Break - Creates a break group on one or several columns. This pulls the
columns out of the interactive report and displays them as a master record. See
“Creating a Control Break”.

¢ Highlight - Defines a filter that highlights the rows that meet the filter criteria.
See “Adding Highlighting”.

* Compute - Enables users to add computed columns to a report. See
“Computing Columns”.

* Aggregate - Enables users to perform mathematical computations against a
column. See “Aggregating a Column ”.

® Chart - Displays the report data as a chart. See “Creating a Chart from the
Actions Menu”.

* Group By - Enables users to group the result set by one or more columns and
perform mathematical computations against columns. See “Grouping
Columns”.

Flashback - Enables users to view the data as it existed at a previous point in time.
See “Executing a Flashback Query”.

Save Report - Saves the interactive report. Depending upon their user credentials,
users can save different types of reports. See “Saving an Interactive Report”.

Reset - Resets the report back to the default report settings. See “Resetting a
Report”.

Help - Provides descriptions of how to customize interactive reports.

Download - Downloads a report. Available download formats depend upon your
installation and report definition. See “Downloading a Report”.

Subscription - Send an interactive report by email. See “Subscribing to Emailed
Reports”

Selecting Columns to Display

To customize a report to include specific columns, select Select Columns on the
Actions menu.

To use the Select Columns option:

1.
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Adding a Filter

Select Columns

Do Mot Display Display in Report
) |Project
5% |Task Name
S Start Date
@ End Date
K Status
Assigned To
Cost
Budget
Available Budget

(EET= =]

Cancel Apply

Select the columns you want to move. Click the center arrows to move a column
from Display in Report to Do Not Display. To select multiple columns at once,
press and hold the CTRL key.

To change the order of the columns, click the Top, Up, Down, and Bottom arrows
on the right.

Click Apply.

A revised report appears.

See Also:

“Resetting a Report”

You can create a filter on an interactive report by adding or modifying the WHERE
clause on the query. You can create two types of filters:

Column - Creates a custom column filter. Select a column, select a standard Oracle
operator (=, ! =, not in, bet ween), and enter an expression to compare against.
Expressions are case sensitive. Use the percent sign (% as a wildcard. Note that the
selected column does not need to be one that currently displays. For example:

STATE_NAME | i ke A%

Row - Creates a custom row filter. This filter creates a complex VWHERE clauses
using column aliases and any Oracle functions or operators. For example:

G="'VA or G="'CT

Where Gis the alias for CUSTOVER_STATE.

Adding a Column Filter

To add a column filter:

1.

Click the Actions menu and select Filter.

The Filter region appears.
For Filter Type, select Column.

In the Filter region, specify a column, an operator, and an expression.
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( Filter

Filter Type @ Calumn ) Row

Caolumn Operator Expression

Project v | = ~ | |Discussion Forum

| Cancel | | Apply |

This example narrows the display to Discussion Forum projects.

4. Click Apply.

Q- Go | Reports | 1. Primary Repaort "|| = | = || Actions ~
= v_|’F'_rqj_ect = Discussion Forum' 7;(
Project Task Name Start DateE] End Date Status Assigned To Cost
o~ Discussion Forum Identify owners 14-JUL12 17-JUL12 Closed Hank Davis 240
o Discussion Forum  Install APEX application on internet server 22-JUL12 22-JUL-12 Clozed Hank Davis 1aa
o Discussion Forum  Monitar participation 23-JUL12 H-JUL-12 Cpen Hank Diavis 450
800
Notice the filter Pr oj ect = ' Di scussi on Forum displays in the Report
Settings area above the report.
5. To revise the filter:
a. Click the filter name (in this example, Pr oj ect = ' Di scussi on Foruni).

b. Edit your selections and click Apply.

6. To disable the filter, select the Enable/Disable Filter check box.

7. To delete the filter, click Remove Filter.
Adding a Row Filter
To add a row filter:

1. Click the Actions menu and select Filter.

The Filter region appears.
2. For Filter Type, select Row.
3. In the Filter region:

a. Name - Enter a name that describes this filter.

b. Filter Expression - Enter an expression. Select a column and function or

operator at the bottom of the region.
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f' Filter

Filter Type ¢ Column @& Raow

Marme |Cust over $5000

Filter Expression &

H = 5000
A
Columns Functions / Operators
B. Project A= ~
C.| Task Name <
D. Start Date <=
E.|End Date =
F. Status >
.| Agsigned To o = o
| Cancel | | Delete || Apply |

4. Click Apply.

= foustover%UDD %

Project Task Name Start Date~) End Date Status Assigned To Cost
& maintain Support HR software upgrades A1-MAY-12 26-JUL-12 On-Hold Pam King g,000
Systems
./ Maintain Support  Apply Billing System I -MAY-12 A0-JuL-12 Cn-Hald Fuss Sanders 9500
Systems updates
./ Email Integration Complete plan 07-JUK-12 13-JUL-12 Closed Mark Mile 3,000

The Row Filter narrows the display to projects with a cost of more than $5000.
5. To revise the filter:

a. Click Row Filter.

b. Edit your selections and click Apply.
6. To disable the filter, select the Enable/Disable Filter check box.
7. To delete the filter, click Remove Filter.

Specifying Rows Per Page

You can specify the number of rows that display on a page by selecting Rows Per
Page on the Actions menu.

To specify the number of rows that display:
1. Click the Actions menu and select Rows Per Page.

2.  From the submenu, select a number.
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Actions ~

Select Columns

Filter
Fer Rage
Farrmat b5
o Flashback 10

15

Save Repart o0

Reset o5

Help 50
100

Download
1000

Subscription
All

Selecting Column Sort Order

You can specify column display sort order (ascending or descending) by selecting Sort
on the Format submenu. You can also specify how to handle NULL values. Using the
default setting always displays NULL values last or always displays them first.

To sort by column:

1. Click the Actions menu and select Format and then Sort.

The Sort region appears.

2. Select a column, the sort direction (Ascending or Descending), and Null Sorting
behavior (Default, Nulls Always Last, or Nulls Always First).

14

25 sort
Column Direction Mull Sarting

1 |Start Date V| |Ascending V| |Default V|
? |End Date V| |Ascending V| |Default V|
3 |F'mject V| |Asu:ending V| |Default V|
4 |— Select Column - V| |Ascending V| |Default V|
5 | Select Column - V| |Asu:ending V| |Default V|
B |— Select Column - V| |Ascending V| |Default V|

| Cancel | | Apply |

3. Click Apply.

Creating a Control Break

You can create a break group of one or several columns by selecting Control Break
from the Actions, Format submenu. Creating a break group pulls the columns out of
the interactive report and displays them as a master record.

To create a break group:
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1. Click the Actions menu and select Format and then Control Break.

The Control Break region appears.

2. Select a column and then a status (Enable or Disable)

Zolumn

1 | Project

2 |- Zelect Column -

3 |- Select Column -

4 |- Select Column -

5 |- Select Column -

B |- Select Column -

3. Click Apply.

Control Break

Cancel

Status

+ | |Enabled

« | |Enabled

“ | |Enabled

“ | |Enabled

“ | |Enabled

“ | |Enabled

A revised report displays.

g Projert [k
Project : Train Developers in APEX
Task Name
Fublish development standards
Fublish links to selfstudy courses

Create training waorkspace

Project : Software Projects Tracking

Task Name

Canduct project kickoff mesting

Note the defined break groups display in the Report Settings area above the

report.

Start Date

23-JUM-12

26-JUM-12

26-JUM-12

Start Date

30-JUM-12

Apply

End Date

29-AUG-12

26-JUN-12

03-JUL-12

End Date

30-JUN-12

Status

On-Hald

Cloged

Clozed

Status

Cloged

Assigned To
John Watson
John Watson

James Cassidy

Assigned To

FPam King

Cost

1,000

100

a00

1 500

Cost

100

Budget
2,000
100

700

2,500

Budget

100

4. To disable the Control Break filter, deselect the Enable/Disable Filter check box.

To enable the filer, select the Enable/Disable Filter check box again.

5. To delete the filter, click Remove Breaks.

Adding Highlighting

You can customize the display to highlight specific rows in a report by selecting

Highlight on the Actions, Format submenu.

To add highlighting:
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1. Click the Actions menu and select Format and then Highlight.
The Highlight region appears.

— | Highlight

Marne |

Sequence |1D |

Enabled
Highlight Type
Background Colar |—||] |:| [yellow] [green] [blue] [orange] [red]
Text Color |—||] ] [yellow] [green] [biue] [orange] [red]
Highlight Condition
Column Ciperator Expression
|F'r0ject V| |: V| | E‘
| Cancel | | Apply |

2. Edit the following information:
a. Name - Enter a name that describes this filter.

b. Sequence - Enter a numeric value to identify the sequence in which
highlighting rules are evaluated.

c. Enabled - Select Yes.
d. Highlight Type - Select Cell or Row.

e. Background Color - Select a new color for the background of the highlighted
area.

f.  Text Color - Select a new color for the text in the highlighted area.

g. Highlight Condition - Select a column, an operator, and expression.

——— Highlight

Marme | Orn-Hald Projects
Sequence | 10 |

Enabled
Highlight Type
Background Color| ||2 |:| [yellow] [green] [blue] [orange] [red
Teut C°|°r|#FF??55 ||] I [yellow] [green] [blue] [orange] [red
Highlight Conditian
Column Ciperator Expression
[Status v [= o] [on-Hold [

| Cancel | | Apply |

3. Click Apply.
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2 x
ProjectE] Task Name Start Date End Date Status
" Train Developers in APEX  Fublish links to selfstudy courses 26-JUN-12 26-JUM-12 Closed
" Train Developers in APEX  Create training workspace 26-JUN-12 03-JuL-12 Closed
" Software Prajects Caonduct praject kickoff meeting 30-JUN-12 30-JUM-12 Clased

Tracking

Computing Columns

Note the highlight On- Hol d Pr oj ect s displays in the Report Settings area
above the report.

To revise the highlight, click the highlight name and make the following edits:

a.

b.

C.

Background Color - Select yellow.
Text Color - Select green.

Click Apply.

To disable the highlight, select the Enable/Disable check box.

To delete the highlight, click Remove Highlight.

You can add computations to columns by selecting Compute from the Actions, Format
submenu. These computations can be mathematical computations (for example,
NBR_HOURS/ 24) or standard Oracle functions applied to existing columns.

To create a computation:

1.

Click the Actions menu and select Format and then Compute.

The Compute region appears.

In the Compute region:

a.

b.

C.

Computation - Select New Computation.
Column Heading - Enter the name of the new column to be created.

Format Mask - Select an Oracle format mask to be applied to the new column.
(for example, $9999).

Next, create the computation.

Create the computation:

¢ Columns - Select a column or alias.

e Keypad - Select a shortcut for commonly used keys.

¢ Functions - Select the appropriate function.

In the following example, a new column compares the actual cost to the
budgeted amount, using the formula H - |, where His the cost and | is the
budgeted amount.
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3.

Project™

& Train
Developers in
APEX

& Train
Developers in
APEX

I Train
Developers in
APEX

Deleting a Computation

To delete a computation:

1.

=

o

ek
i

4 Compute

Camputation |_ Mew Computation - v|

Colurmn Heading | Cost Analysis

Computation Expression &

| Format Mask [Py 599G9996999G899G2000 ]

H-1
4
Columns Keypad Function

L ' -~
D. Start Date = (] I sIGN i
E. End Date |8 SIN
F. Status 4 5 B + S0QRT
G Assigned To 1 23 SUBSTR
H. Cast 0 f BYSDATE

| Budget Space . SYSTIMESTAMP
K. Awailable Budget = THEN 2
Create a computation using column aliases.
Examples:
1. (B+Cy*100
2. INITCAREN, JIMITCAPC)
3. CASE WHEN A =10 THEN B + C ELSE B END
| Cancel | | Apply |

Click Apply.

The revised report appears containing a new Cost Analysis column.
Task Name Start Date End Date Status Assigned To Cost Budget
Fublish 23-JUn-12 29-AUG-12 On-Hold John Watson 1,000 2,000
development
standards
Fublish links to 26-JUN-12 26-JUN-12 Closed John Watson 100 100
self-study
courses
Create training  26-JUN-12 03-JUL-12 Closed James Cassidy a00 700

workspace

Click the Actions menu and select Format and then Compute.

The Compute region appears.

From Computation, select a computation.

The computation appears.

Click Delete.
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Aggregating a Column

You can define an aggregation against a column by selecting Aggregate from the
Actions, Format menu. Aggregates are displayed after each control break and at the
end of the report within the column for which they are defined.

To aggregate columns:

1. Click the Actions menu and select Format and then Aggregate.
The Aggregate region appears.
2. Inthe Aggregate region:
a. Aggregation - Select New Aggregation.
b. Function - Select one of the following: Sum; Average, Count, Count Distinct,
Minimum, Maximum, or Median.
c. Column - Select a column.
T Aggregate
Agaregation [ Sum - Cost 3
Function [sym 3
Calumn [ oqet 3
Cancel Delete Apply
This example creates a sum of the Cost column.
3. Click Apply.
The computation appears at the bottom of the report.
ProjectE] Task Name Start Date End Date Status Assigned To Cost Budget
" APEX Environment Create pilot workspace 05-JUnN-12 05-JUnN-12 Closed John Watson 100 100
Configuration
" APEX Emviranment Caonfigure Workspace 05-JUn-12 05-JUN-12 Closed John Watson 200 100
Canfiguration pravisioning
" APEX Emviranment Run installation 0B-JUn-12 0B-JUN-12 Closed James Cassidy 100 100
Configuration
56,150

In this example, the aggregate shows the sum of all amounts in the Cost column.

Removing an Aggregate

To remove aggregate columns:

1.

2.

Click the Actions menu and select Format and then Aggregate.

The Aggregate region appears.

From Aggregation, select a previously defined aggregation.
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3. Click Delete.

Creating a Chart from the Actions Menu

To create a chart, select Chart on the Actions, Format menu. You can create one chart
for each interactive report. Once defined, you can switch between the chart and report
views using links on the Search bar.

To create a chart:

1. Click the Actions menu and select Format and then Chart.

The Chart region appears.

2. In the Chart region, specify the appropriate options.

iid Chart
Chart Type = .
@‘i O\M o) \2 oL=
Lahel |F'rDject v| Ais Title for Label |F'r0jects |
Walue |Budget v| Axis Title for Walue |Eluc|get |
Function |Sur‘r‘| v|

Sort [value - Ascending v |

| cancel | | Apply |

The following attributes are for bar charts:

a. Chart Type - Select the type of chart you want to create (horizontal bar,
vertical bar, pie, or line.).

b. Label - Select the column to be used as the label.

c. Axis for Title for Label - Enter the title to display on the axis associated with
the column selected for Label (not available for pie chart).

d. Value - Select the column to be used as the Value. If your function is a COUNT,
a Value does not need to be selected.

e. Axis Title for Value - Enter the title to display on the axis associated with the
column selected for Value (not available for pie chart).

f.  Function - (Optional) Select a function to be performed on the column
selected for Value.

g. Sort - Select a sorting method.

3. Click Apply.
The chart appears.
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‘ |Qv | Go | Reports | 1. Primary Report V| | = | 2 | | Actions ~ |
o Edit Chant

Discussion Forum
Environment Configuration
Saoftware Prajects Tracking
Emplovee Satisfaction Survey
Train Developers in APEY
Public Website

Email Integration

Bug Tracker

Load Packaged Applications

Projects

Mainkain Support Systems
Convert Excel Spreadsheet;

Migrate Access Application

Migrate fram SOL Server

Forms Conersion

T T T T T 1
0.00 5, 000, 00 10,000.00 15,000,000  20,000.00 25,000,000  30,000.00

Budget

Note the Search bar now contains two icons: View Report and View Chart.
4. Click these icons to toggle between chart and report views.
Editing a Chart
To edit a chart:
1. While viewing a report:

a. Click the Actions menu and select Format and then Chart.

The Chart region appears.

b. Edit your selections and click Apply.
2. While view the chart:

a. Click Edit Chart.

b. Edit your selections and click Apply.
Deleting a Chart
To delete a chart:
1. While viewing a report:

a. Click the Actions menu and select Format and then Chart.

The Chart region appears.
b. Click Delete.
2.  While viewing a chart:
a. Click Edit Chart.

b. Click Delete.

Using Interactive Reports  3-17



Using the Actions Menu

Grouping Columns

Group By enables users to group the result set by one or more columns and perform
mathematical computations against the columns. Once users define the group by, they
can switch between the group by and report views using the View Icon on the Search
bar.

Topics:

¢ Creating a Group By
e Editing a Group By
¢ Deleting a Group By
Creating a Group By
To use Group By:

1. Click the Actions menu and select Format and then Group By.

The Group By region appears.

2 Group By

Group By Column

1]- Select Colurnn - %] 2[- Select Colurmn - %[ 3| - Select Colurnn - v

Functions Column Label Format Mask Sum
1|- Select Function - v |- select Column - ¥ Il e O
2 |— Select Function - VH— Select Column - VH | ‘ Iil O
3|- Select Function - ~ |- Select Column - ¥ | I M O
| Cancel | |W|

2. From Group by Column, select up to three columns to display.
3. Toinclude a computation, select the function, column, label, and format mask.

4. To specify sorting, select a sort column, sort direction, and preferences for NULL
values.

Z Group By

Group By Colurmn

1| Project v|2 | Task Mame +| 3| Budget ~|

Functions Column Label Format Mask Sum
1/ Sum v || Cost o |[ Total Cast | [FVL938Go95Go9969996390000 |
2|- Select Function - v | - Select Column - +|| I I O
3|- Select Function - v | - Select Column- v|| I I O

| Cancel | | Delete || Apply |

5. Click Apply.
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Q- Go | Repors | 1. Primary Report = | = Actions ~
o Edit Graup By
Project Task Name EBudget Total Cost
Maintain Support Systems HR software upgrades 7,000 $2,000.00
APEX Ervironmment Configuration  Create pilot workspace 100 $100.00
Discussion Forum Identify owners 300 5250.00
Discussion Forum Install APEX application on internet serar 100 $100.00
Migrate Access Application Flan migration schedule 200 $600.00

A Group By icon appears below the Search bar. The resulting report displays the
Project, Task Name, and Budget columns. Additionally, a new column, Total Cost,
displays on the right side.

Editing a Group By
To edit a group by:
1. Click Edit Group By.
The Group By region appears.
2. Edit the attributes.
3. Click Apply.
Deleting a Group By
To delete a group by:
1. Click Edit Group By.
The Group By region appears.
2. Click Delete.
Selecting a Group By Sort Order

You can specify group by column sort order (ascending or descending) by either
clicking on the group by column heading or selecting Group By Sort on the Format
submenu. You can also specify how to handle NULL values. Using the default setting
always displays NULL values last or always displays them first.

To sort a group by column:

1. Access a Group By view. See “Creating a Group By”.

2. Click the Actions menu and select Format and then Group By Sort.
Tip:

The Group By Sort menu is only visible when you are viewing Group By
view.

The Group By Sort region appears.
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14
3% Group By Sort

Column Direction Mull Sorting
1-Select Column- + || Ascending |~ || Default hd
2 |- Zelect Calumn - ¥ || Ascending v || Default hd
3|-SelectColumn- ¥ || Ascending || Default hd
4|-Select Column- ¥ || Ascending || Default b4
5|-SelectColumn- ¥ || Ascending || Default hd
6 |-Select Calumn- ¥ || Ascending v || Default hd

Cancel Apply

3. Select a column, the sort direction (Ascending or Descending), and Null Sorting
behavior (Default, Nulls Always Last, or Nulls Always First).

4. Click Apply.

Executing a Flashback Query

You can execute a flashback query by selecting Flashback from the Actions menu. A
flashback query enables you to view the data as it existed at a previous point in time.
The default amount of time that you can flashback is 3 hours (or 180 minutes) but the
actual amount is different for each database.

To execute a flashback query:
1. Click the Actions menu and select Flashback.
2. In the Flashback region, enter the number of minutes.

3. Click Apply.

Saving an Interactive Report

As an end user, you can save a private or public interactive report. Only the user who
creates a private report can view, save, rename, or delete it. The following shows the
Reports list on the Search bar of an interactive report.

Q- Go | Reports | 1. Primary Report  %| | = | == Actions ~ Reset Report
Defauft
1. Primary Report
Project Task Name Star Private Status Assigned To Cost Budget
, 1. Control Break
E APEX Ervironrment Identify server requirernents  27-MAY-12 28-MAY-12 Closed John Watson 100 200
Configuration
" Maintain Support HR software upgrades 27-MAY12 22-JUL-12 Or-Hald Parn King 8,000 7,000

Systerms

This example shows two reports:

* Default - Primary Report. This is the initial report created by the application
developer. Default, Primary reports cannot be renamed or deleted.

e Private - 1. Control Break. This is a Private report. Only the user who creates a
private report can view, save, rename, or delete it.
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Topics:

About Configuration Dependencies
Saving a Public or Private Interactive Report
Renaming a Public or Private Interactive Report

Deleting a Public or Private Interactive Report

About Configuration Dependencies

The ability to save an interactive report is configurable by your application developer.
To learn more, see "Customizing the Search Bar" and "Saving an Interactive Report" in
Oracle Application Express Application Builder User's Guide.

Saving a Public or Private Interactive Report

End users can save an interactive report and classify it as being either:

Public. The report can be saved, renamed, or deleted by the end user who created
it. Other users can view and save the layout as another report.

Private. Only the end user that created the report can view, save, rename or delete
the report.

To save a public or private interactive report:

1.

2.

Go to the page containing the interactive report you want to save.

Customize the report (for example, hide columns, add filters, and so on). See
“Using the Actions Menu”.

Click the Actions menu and select Save Report.

The Save Report region appears.

-I.:EIH Save Report

Marne O ruslic

Description

Cancel Apply

In Save Report:
a. Name - Enter a name for the report.
b. Description - Enter an optional description.

c. Public - Select this check box to make the report viewable to all users.
Deselect this check box to make the report private.

Tip:

The ability to save an interactive report as Public is determined by your
application developer. See “About Configuration Dependencies”.

d. Click Apply.
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Renaming a Public or Private Interactive Report

To rename a public or private interactive report:

1.

2.

4.

5.

Run the report as a developer.
Select a public or private interactive report to rename.

Click the Rename Report link.

Q- Go | Reports | 1. By Cwner
Saved Report = "By Cwner" b
= assigned To %

Edit the attributes (for example, enter a new name).

Click Apply.

Deleting a Public or Private Interactive Report

To delete a public or private interactive report:

1.

2.

Q-

= Saved Report = "By Owher”

Run the report as a developer.

Click the Delete Report icon next to the report name link.

Go | Reports | 1. By Owwner =

Project Task Name

3.

Click Apply.

Resetting a Report

You can reset a report back to the default settings by selecting Reset from the Actions
menu. Resetting a report removes any customizations you have made.

To reset a report:

1.

2.

Click the Actions menu and select Reset.

Click Apply.

Downloading a Report

hd Actions «

= Actions ~

End Date Status Assigned Tol™ Cost Budget

You can download an interactive report back by selecting Download from the Actions
menu. Available download formats depend upon your installation and report
definition. Supported formats include comma-delimited file (CSV) format, HTML,
Email, Microsoft Excel (XLS) format, Adobe Portable Document Format (PDF), and
Microsoft Word Rich Text Format (RTF).
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Tip:

The ability to download an interactive report is configurable by your
application developer. To learn more about configuring download options,
see "Configuring Download Options on the Actions Menu" in Oracle
Application Express Application Builder User’s Guide.

To download a report:

1. Click the Actions menu and select Download.

2. Select a report download format and follow the provided instructions.

Subscribing to Emailed Reports

End users can receive updated versions of a report by subscribing to it. To subscribe to
a report, click Subscription on the Actions menu. Emails sent from an interactive
report contain a system generated email signature that cannot be overwritten that
identifies who originated the email.

To utilize Subscription:

¢ An Oracle Application Express administrator must configure email at the Instance
level.

¢ The application developer must enable the Subscription check box on the
Interactive Report Attributes page. See "Customizing the Interactive Report Search
Bar" in Oracle Application Express Application Builder User’s Guide.

To receive updated report results by email:

1. Click the Actions menu and select Subscription.

The Add Subscription region appears.

2. Under Add Subscription:

a.

Email Address - Enter the email addresses to receive the report. To include
multiple email addresses, separate each email address with a comma.

Subject - Enter text to display in the email subject line.

Frequency - Select the interval at which the report is sent.

Starting From - Select a start date and time.

Ending - Select an end date and time. Select a day, week, month, or year.

Click Apply.

Note:

Emails sent from a subscription include a system generated email signature
indicating who created the subscription. This signature cannot be removed.
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See Also:

"Managing Interactive Report Subscriptions" in Oracle Application Express
Administration Guide
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About Uploading Data

This section describes how to import data into an Oracle Application Express
application using an existing application Data Loading Wizard.

Tip:

To use the functionality described in this section, your application must be
built with Data Upload capability. To learn more, see "Creating Applications
with Data Loading Capability" in Oracle Application Express Application Builder
User’s Guide.

Topics:

¢ About Using the Data Loading Wizard

* Importing Data from a File into Your Application
¢ Copying and Pasting Data into Your Application

¢ Automatically Supported Date_ Timestamp and Number Formats

About Using the Data Loading Wizard

Applications with data loading capability enable end users to dynamically import data
into a table within any schema to which the user has access. End users run a Data
Load Wizard that uploads data from a file or copies and pastes data entered by the
end user directly into the wizard.

The Data Loading wizard for your application may have been built to include the
ability to apply table lookup and transformation rules during the data upload process.
Before the data is actually imported into the database, you are given the opportunity
to review the data after all look up and transformation rules have been applied.

* Table Lookups - These rules automatically map data in the import file or copy and
paste field to data that is found in another table. For example, if the import file
contains a department name for the DEPTNO column but the upload table requires a
number for that column, use a table lookup rule to find the corresponding
department number for that department name in another table.

e Data transformation rules - These rules automatically perform formatting
transformations such as changing import data to uppercase, lowercase, and so on.
For example, if the import file includes column data with both upper and
lowercase and the destination table requires all uppercase, data transformation
rules can automatically insert only uppercase into that column during data upload
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Importing Data from a File into Your Application

To upload data to your application, the application must have been built with Data
Upload capability and the file must be formatted properly.

To illustrate how you can use the Data Load wizard to import data from a text file, the
following section demonstrates the upload process and includes examples from the
sample packaged application, Sample Database Application.

See Also:

"Utilizing Packaged Applications" and "About Sample Database Application”
in Oracle Application Express Application Builder User’s Guide

To import data from a file into the sample packaged application, Sample Database
Application:

1. Loginto the sample packaged application, Sample Database Application.

2. On the Customers page, click Upload Data to launch the Data Load wizard.
The Data Load wizard appears.

3. For Data Source Load:

a. Import From - Select Upload file, comma separated (*.csv) or tab delimited.

The Data Load Source page appears with options for loading from a data file.

Data Load Source Data/Table Mapping Data Validation Data Load Results

* Import From ® Upload filz, comma zeparated (".z2vi or tab delimited
@] Copy and Pasts

Separator it [2]

Optionally Enclosed By " (2]

First Row haz Colurmn Mves

Names

File Character Set JTF-2 "

* File Name Mo file chosen (2]

Currency Symbol b [2]

Group Separator ) 7]

Decimal Character . [2]

b. Separator - Enter the column separator character. Use \ t for tab separators.

c. Optionally Enclosed By - Enter a delimiter character to delineate the start and
end boundary of a data value.

d. First Row has Column Names - Options include:
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¢ Yes - Columns are named with column names from the first row of the
uploaded data file.

* No - Columns will not be named with column names from the uploaded
data file.

File Character Set - Select the file character set associated with the file to be
uploaded.

File Name - Browse to the file name containing the data to upload.

The following example shows an example cust oner . t xt data load file.

I customer, txt - Notepad
Fle Edit Format Yiew Help

Polard  Jaohn
Handruff Cary
King Sally

CUST_LAST_MAME
Logan  Edward 2 Harborside Drive Boston  MA - 43357
290" Maple Drive Austin TX 45398
555 Walnut Street Newton MA 66554
61 Trailer Place Boulder CO 54354

CUST_FIRST_MNAME CUST_STREET_ADDRESS1 CUST_CITY  CUST_STATE CUST_POSTAL_CODE

Ln 1, Col 1

4.

< Cancel

Column Mapping

Date / Number Format
First Row Column Names
Row1
Row2
Row3

Rowd

Currency Symbol - If your data contains an international currency symbol,
enter it here. For example, if your data has "$1,234.56" or "©1,234.56", enter $
or ©. Otherwise the data may not load correctly.

Group Separator - If your data contains a group separator, enter it here. A
group separator is a character that separates integer groups, for example, to
show thousands and millions.

Any character can be the group separator. The character specified must be
single-byte, and the group separator must be different from any other decimal
character. The character can be a space, but cannot be a numeric character or
any of the following: plus sign (+), hyphen (- ), less than sign (<), or greater
than sign (>).

Decimal Character - If your data contains a decimal character, enter it here.
The decimal character separates the integer and decimal parts of a number.
Any character can be the decimal character. The character specified must be
single-byte, and the decimal character must be different from any other group
separator. The character can be a space, but cannot be a numeric character or
any of the following: plus sign (+), hyphen (- ), less than sign (<), or greater
than sign (>)

Click Next.
The Data/Table Mapping page appears.

Data Load Source Data/Table Mapping Data Validation Data Load Resultz

|Last Marme V| |First MName V| |Street Addre V| |City V| |State V| ‘F‘ostal Code V|

CUST LAST NAME  CUST FIRST MAME  CUST STREET ADDRESZ1  CUST CITY CUST STATE CUST POSTAL CODE

Logan Eclward 2 Harl

e Dirive Eoston 14 43357

Palard Jahn 280" Maple Drive Austin TH 45398

Handruff Cary 555 Walnut

King

Mewton 1A GE554

Sally &1 Trailer Flace Boulder co 54354
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5. For Data/Table Mapping:

a. Column Mapping - Indicates the destination column name. To change the
column name, select a new column name from the list. To hide a column,
select Do Not Load.

b. Date/Number Format - Most of the standardized date and number formats
are automatically parsed and then passed to the database. If you want to
define your own format or the format is not an automatically parsed format,
use this field to define your own. See “Automatically Supported Date_
Timestamp and Number Formats”.

c. Click Next.

The Data Validation page appears showing the data to be inserted or updated
after any table lookup and transformation rules have been applied. For more
information regarding table look up and transformation rules, see “About Using
the Data Loading Wizard”.

¢ || cancel w v O ® Load Data %
_— Data Load Source Data/Table Mapping Data Validation Data Load Results

Sequence Action Last Name First Name Street Address  City State Postal Code

1 UPDATE Logan Edward 2 Harborside Drive Boston MA 43357
2 INSERT Polard John 290 Maple Drive  Austin TX 45298
2 INSERT Handruff  Cary 535 Walnut Street Newton MA 66334
4 INSERT King Sally 61 Trailer Place  Boulder CO 54354

6. Review the data to be uploaded and click Load Data.
The Data Load Results page appears.

] w v 6 View Customers
Data Load Source Data/Table Mapping Data Validation Data Load Results

Inzerted Row(s): 3
Updated Row(z): 1
Failed Row(s): 0

To be Reviewed Row(s): 0

The Data Load Results page displays:
¢ Inserted Row(s) - This is the number of new rows uploaded to the table.

* Updated Row(s) - This is the number of rows in the table updated with new
information.

e Failed Row(s) - This is the number of rows from the upload file that were not
added or updated.

* To be Reviewed Row(s) - This is the number of rows needing review.

7. Click View Customers to return to the Customers page.
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Copying and Pasting Data into Your Application

To upload data to your application, the application must have been built with Data
Upload capability and the pasted data must be formatted properly.

To illustrate how you can use the Data Load wizard to copy and paste data from a text
file, the following section demonstrates the upload process and includes an illustration
of the sample packaged application, Sample Database Application.

To copy and paste data into your application:
1. Log into the sample packaged application, Sample Database Application.

2. On the Customers page, click Upload Data to launch the Data Load wizard.
The first page of the Data Load wizard appears.

_— Data Load Source Data fTable Mapping Data Validation Data Load Results

* Import From O Upload file, comma separated (".csv) or tab delimited
® Copy and Paste

Separator it 2]
Optionally Enclosed " 2]
By

First Row has Colurmn ¥y ez
Names

File Character Set ITF-2 “

* Copy and Paste Delimited Data

GCurrency Symbol %
Group Separator

Decirmal Character

o Sample Data 2% Inzert Sample Data

3. For Data Source Load:
a. Import From - Select Copy and Paste.
b. Separator - Enter the column separator character. Use \ t for tab separators.

c. Optionally Enclosed By - Enter a delimiter character to delineate the start and
end boundary of a data value.

d. First Row has Column Names - Options include:
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¢ Yes - Columns are named with column names from the first row of the
uploaded data file.

* No - Columns will not be named with column names from the uploaded
data file.

e. File Character Set - Select the file character set associated with the data to be
copied.

f.  Copy and Paste Delimited Data - Click the Insert Sample Data button at the
bottom of the page.

The sample data appears in the Copy and Paste Delimited Data field.

—_— Data Load Source Data/Table Mapping Data Validation Data Load Results

* Import From Q Upload file, comma zeparated (" .cov) or tab delimitzd
[OF e py and Paste

Separator \ (7]

Optionally Enclozed By " [2]

First Row has Column Yes

Names

File Character Set UTF-8 I

* Copy and Paste Delimited Data
First Hame,Last Name,Street Address,City,State,Postal Code,Email,Phone e
Number,Alternate Number,Credit Limit,Tags
John, Dulles, 5987 Whitehart
Lane, Chicago, I11inois, 686086, john.dulles@mailman. com, 312 -666-5987, 720-666-
1234,4000, Hew Address
Peter,Williams,1212 Technology Way,Denver,{olorado,88227,,383-555-6688,,1580,
Susan, Peters, 9008 Reston =
Parkway,Reston,Virginia, 20191, susan. peters@email.com,703-999-5467,703-123-
9876, 2500, 4
Albert,Lambert,2468 Longmire Place,St. lLouis,Missouri,63149,,314-000- P

Currency Symbol 5 2]

g. Currency Symbol - If your data contains an international currency symbol,
enter it here. For example, if your data has "$1,234.56" or "©1,234.56", enter $
or ©. Otherwise the data will not load correctly.

h. Group Separator - If your data contains a group separator enter it here. A
group separator is a character that separates integer groups, for example to
show thousands and millions.

Any character can be the group separator. The character specified must be
single-byte, and the group separator must be different from any other decimal
character. The character can be a space, but cannot be a numeric character or
any of the following: plus sign (+), hyphen (- ), less than sign (<), or greater
than sign (>).

i.  Decimal Character - If your data contains a decimal character, enter it here.
The decimal character separates the integer and decimal parts of a number.
Any character can be the decimal character. The character specified must be
single-byte, and the decimal character must be different from any other group
separator. The character can be a space, but cannot be a numeric character or
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< Cancel

Column Mapping

Date / Number Format

any of the following: plus sign (+), hyphen (- ), less than sign (<), or greater
than sign (>)

Click Next.
The Data/Table Mapping page appears.

@ o
Data Load Source Data/Table Mapping Data Validation Data Load Results

|Last Name V| |First Name v| |StreetAddre V| |City V| |State V| ‘Postal Code V|

First Row Column Names ~ CUST LAST NAME  CUST FIRST MAME CUST STREET ADDRESS1  CUST CITY STATE CUST POSTAL CODE
Row1 Logan Eclwarc 2 Harborzice Drive Baoston [EY 43357
Row2 Folard Johin 280" Maple Drive Austin Tx 45398
Row3 Hariclruff Cary 555 Walnut Stree Mewton BE554
Rowd King Sally &1 Trailer Flace Eoulder 54354
5. For Data/Table Mapping;:

a. Column Mapping - Indicates the destination column name. To change the
column name, select a new column name from the list. To hide a column,
select Do Not Load.

b. Date/Number Format - Most of the standardized date and number formats
are automatically parsed and then passed to the database. If you want to
define your own format or the format is not an automatically parsed format,
use this field to define your own. See “Automatically Supported Date_
Timestamp and Number Formats”.

c. Click Next.

6. Click Next.

The Data Validation page appears showing the data that to be inserted or updated

after any table lookup and transformation rules have been applied. For more

information regarding table look up and transformation rules, see “About Using

the Data Loading Wizard”.

< || cancel “ = 6 ® Load Data £#
—_— —— Data Load Source Data/Tahle Mapping Data Validation Data Load Results
Sequence Action First Name Last Name Street Address  City  State Postal Code Email Phone Number Alternate Number
1 UFPDATE John Culles 5287 Whitehart Chicago  IL 60606 john.dulles @ mailman.com 212-666-5887  720-666-1234
Lane
2 INSERT  Peter Williams 1212 Denver GO 80227 303-555-6688
Technology
Way
3 INSERT  Susan Peters 9000 Reston  Reston VA 20191 susan.peters @email.com  703-999-3467  702-123-9876
Parkway
4 UFDATE Albert Lambert 2462 Longmire St Louis MO 63142 214-000-1000
Place
5 INSERT Bob Uncle 228 Mason St San CA 4110 bob.uncle@ mail.com
Francisco
7. For Data Validation, review the data to be uploaded and click Load Data.

The Data Load Results page appears.
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@ @ @ O View Customers
Data Load Source Data fTable Mapping Data Validation Data Load Results

Inzerted Row(s): 3
Updated Row(z): 2
Failed Row(s): 0

To be Reviewed How(s): 0

The Data Load Results page shows:
¢ Inserted Row(s) - This is the number of new rows uploaded to the table.

* Updated Row(s) - This is the number of rows in the table updated with new
information.

¢ Failed Row(s) - This is the number of rows from the upload file that were not
added or updated.

* To be Reviewed Row(s) - This is the number of rows needing review.

8. Click View Customers to return to the Customers page.

Automatically Supported Date, Timestamp and Number Formats

During the data upload process the following date, timestamp and number formats
are automatically parsed and passed to the database.

Automatically Supported Date Format Masks
' MM DD/ RRRR

' DOF MM RRRR

' DD MM RR

' f mMvM DY RRRR

" f nDD/ f MVM RRRR
' DD- MMt RR

' DD. MM RRRR

' DO MOV RR

' RRRR- MMt DD

' DD- MMt RRRR

' f DD/ MM RRRR

" RRRR/ MM DD
'DD. M RR

' f TRRRR/ MM DD

" f nrDD. MM RRRR

' MM DD/ RRRR
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' RRRR. MM DD
" f nDD- MM RRRR
' RRRR- MMt DD' T" hh24: mi : ss'

Automatically Supported Timestamp Format Masks
' DD MM RR HH24. M . SSXFF'

'DD. MM RR HH: M : SSXFF PM

' DD MM RR HH: M : SSXFF PM

' DD- MON- YYYY HH24: M

' DD- MON- YYYY HH24. M . SSXFF'

' DD- MON- YYYY HH: M : SSXFF PM

' DD- MON- YYYY HH24: M TZR

' DD- MON- YYYY HH24. M . SSXFF TZR

' DD- MON- YYYY HH. M . SSXFF PM TZR

Automatically Supported Number Format Masks
" FML999(3999(99(3999(@90D00"

' 999(G999(3999G9993990D00"

' 999(@99(3999(E99E90D0000"

' 999(@99(3999(99E99EFP99E90"

' 99999399999 90D00M '

' S999(G999P99GI99R90D00"

' 99999399999 90D00PR
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